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REFERENCES

CONVENTIONS

This manual uses the following conventions:

"User" refers to anyone using a Matrix 210™ reader.

"Reader" refers to the Matrix 210™ reader.

"You" refers to the System Administrator or Technical Support person using this manual to
install, configure, operate, maintain or troubleshoot a Matrix 210™ reader.

REFERENCE DOCUMENTATION

For further details refer to: the VisiSet™ Help On Line, Matrix Reading Methods, Matrix Host
Mode Programming, Matrix SW Parameter Guide, Matrix Code Quality Verifier Solution
provided as supplementary documentation on Mini-DVD.

SUPPORT THROUGH THE WEBSITE

Datalogic provides several services as well as technical support through its website. Log on
to www.datalogic.com and click on the Industrial Automation links for further information:

¢ Products - Industrial Automation - Identification

Select your product from the links on the Identification page. The product page
describes specific Info, Features, Applications, Models, Accessories, and Downloads
including documentation, software drivers, and the VisiSet™ ultility program, which allows
device configuration using a PC through Serial and Ethernet interfaces.

e Support & Services - Industrial Automation

Several links from the Industrial Automation list take you to additional services such as:
Service Program which contains Maintenance Agreements and Warranty Extensions;
Repair Centers; On-Line RMA Return Material Authorizations; Technical Support through
email or phone, Partner Program; Downloads for additional downloads.

PATENTS

This product is covered by one or more of the following patents:

U.S. patents: 6,512,218 B1; 6,616,039 B1; 6,808,114 B1; 6,997,385 B2; 7,102,116 B2;
7,282,688 B2

European patents: 999,514 B1; 1,014,292 B1; 1,128,315 B1.
Additional patents pending.

Vi



COMPLIANCE

For installation, use and maintenance it is not necessary to open the reader.

Only connect Ethernet and dataport connections to a network which has routing only within
the plant or building and no routing outside the plant or building.

EMC COMPLIANCE

In order to meet the EMC requirements:

e connect reader chassis to the plant earth ground by means of a flat copper braid shorter
than 100 mm;

e for CBX connections, connect the pin "Earth" to a good Earth Ground;

e for direct connections, connect the main interface cable shield to pin 1 of the 25-pin
connector.

POWER SUPPLY
ATTENTION: READ THIS INFORMATION BEFORE INSTALLING THE PRODUCT

This product is intended to be installed by Qualified Personnel only.

This product is intended to be connected to a UL Listed Computer which supplies power
directly to the reader or a UL Listed Direct Plug-in Power Unit marked LPS or “Class 2”, rated
10 to 30 V, minimum 500 mA.

LED SAFETY
LED emission according to EN 62471

CE COMPLIANCE

Warning: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

FCC COMPLIANCE

Modifications or changes to this equipment without the expressed written approval of Datalogic could void the
authority to use the equipment.

This device complies with PART 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference which may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause
harmful interference in which case the user will be required to correct the interference at his own expense.

vii



HANDLING

The Matrix 210™ is designed to be used in an industrial environment and is built to withstand
vibration and shock when correctly installed, however it is also a precision product and
therefore before and during installation it must be handled correctly to avoid damage.

¢ avoid that the readers are dropped (exceeding shock limits).

e do not fine tune the positioning by striking the reader or bracket.

O
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do not weld the reader into position which can cause electrostatic, heat or reading
window damage.

do not spray paint near the reader which can cause reading window damage.




GENERAL VIEW

Matrix 210™

Figure A
@ Mounting Holes (4) Ethernet Network Presence @ Reading Window
LED (for Ethernet Models)
@ "Power ON" LED @ HMI X-PRESS™ Interface @ Device Class Labels




RAPID CONFIGURATION o

1 RAPID CONFIGURATION

STEP 1 — CONNECT THE SYSTEM
25-Pin Models

To connect the system in a Stand Alone configuration, you need the hardware indicated in
Figure 1. In this layout the data is transmitted to the Host on the main serial interface. Data
can also be transmitted on the RS232 auxiliary interface independently from the main
interface selection.

When One Shot or Phase Mode Operating mode is used, the reader is activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

PG 6000

| =—=
Matrix 210™ | e
Host
I- T 71 ﬂ_ - =1 * External Trigger or Presence Sensor
[ | P.s.* /0, AUX (for One Shot or Phase Mode)

Figure 1 — Matrix 210™ in Stand Alone Layout
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CBX100/CBX500 Pinout for Matrix 210™ 25-Pin Models

The table below gives the pinout of the CBX100/CBX500 terminal block connectors. Use this
pinout when the Matrix 210™ reader is connected by means of the CBX100/CBX500:

CBX100/500 Terminal Block Connectors
Input Power Outputs
Vdc Power Supply Input Voltage + +V Power Source - Outputs
GND | Power Supply Input Voltage - -V Power Reference - Outputs
Earth | Protection Earth Ground o1+ Output 1 +
01- Output 1 -
Inputs 02+ Output 2 +
+V Power Source — External Trigger 02- Output 2 -
1A External Trigger A (polarity insensitive) Auxiliary Interface
1B External Trigger B (polarity insensitive) TX Auxiliary Interface TX
-V Power Reference — External Trigger RX Auxiliary Interface RX
+V Power Source — Inputs SGND | Auxiliary Interface Reference
I2A Input 2 A (polarity insensitive) ID-NET™
2B Input 2 B (polarity insensitive) REF Network Reference
-V Power Reference — Inputs ID+ ID-NET™ network +
Shield ID- ID-NET™ network -
Shield | Network Cable Shield
Main Interface
RS232 RS485 Full-Duplex RS485 Half-Duplex
X TX+ RTX+
RTS TX- RTX-
RX *RX+
CTS *RX-
SGND SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.

Do not connect GND, SGND and REF to different (external) ground
& references. GND, SGND and REF are internally connected through filtering
circuitry which can be permanently damaged if subjected to voltage drops

CAUTION  over 0.8 Vdc.
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USB Models

Before connecting the reader to the USB Port, Install the USB Virtual COM
Port Driver from the Support Files\Software Ulilities\USB Virtual COM Port

NOTE Drivers directory on the VisiSet Mini-DVD.

The USB Virtual COM Port Driver allows sending serial data using the Matrix 210™ USB
port. A different virtual COM Port will be assigned to each connected reader.

Installing the USB Virtual COM port drivers:

1. Double-click on the following file to launch the USB Virtual COM Port Driver Installer.
Windows XP/Vista/7 (x32) = "DPInst.exe" Windows Vista/7 (x64) = "DPInstx64.exe"
For other operating systems see the readme txt in the Support Files\Software Utilities\USB

Virtual COM Port Drivers directory. For updated drivers or more details go to
ftdichip.com/Drivers/VCP.htm.

Configuring the USB Virtual COM port:

Connect the Matrix 210™ USB reader to your PC; a new virtual COM port is associated with
the reader. Follow these steps to configure the associated COM Port:

Right-click on "My Computer" in the Windows "Start" menu and select "Properties".

Select the "Hardware" tab in the System Properties dialog and click the "Device
Manager" button.

4. Expand the "Ports (COM & LPT)" item on the "Device Manager" menu. Right-click on
"USB Serial Port" and select "Properties”.

5. Select the "Port Settings" tab in the "Properties” dialog and click the "Advanced" button.
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6. From the "Advanced Settings for COMx" dialog:

o Expand the "COM Port Number" menu and select a new COM Port number if
desired (optional).

e Set the "BM Options" -> "Latency Timer" (msec) parameter to 1.

Advanced Settings for COM2

COM Port Murnber: lCDMZ )|
USE Transfer Sizes
Select lower settings to conect performance problems at low baud rates.
Select higher settings far faster performance.
Receive [Bytes): | 4096 V
Tranzmit [Bytes): | 4096 V
Bt Options Mizcellaneous Options
Select lower settings to conect responze problems. Serial Enumerator
: —_— Serial Printer [El
Latency Timer [msec): |1 |
— - Cancel If Powwer Off ™
Timeouts Ewent On Surprise Remowval 1
B - Set RTS On Cloze O
Minimum Fead Timeout (mseck D i) Disable Modern Ctl &t Stattup [
inimumm ‘afrite Timeout [mzec]: I.D ;

You are now ready to use the new COM Port.

Matrix 210™ USB models can be connected in a Point-to-Point layout to a local host through
their USB cable. No external power supply is necessary.

Matrix 210™

| I

Figure 2 — Matrix 210™ USB Model in a Point-to-Point Layout
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STEP 2 - MOUNT AND POSITION THE READER

1. To mount the Matrix 210™, use the mounting brackets to obtain the most suitable
position for the reader. Two of the most common mounting configurations are shown in
the figures below. Other mounting solutions are provided in par. 3.3.

:E; Tilt

Figure 3 —Positioning 90° Model with Mounting Bracket

:Eb Tilt

Figure 4 —Positioning Straight Model with Mounting Bracket

2. When mounting the Matrix 210™ take into consideration these three ideal label position
angles: Pitch or Skew 10° to 20° and Tilt 0°, although the reader can read a code at any tilt
angle.

o

\ \Ls »J T
‘ Assure at least 10° ‘ Minimize ' Minimize

Figure 5 — Pitch, Skew and Tilt Angles

\
’ [t \

(l
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3. Refer to the Reading Features table in chp. 7 to determine the distance your reader
should be positioned at.

Rapid Configuration of the Matrix 210™ reader can be made either through

the X-PRESS™ interface (steps 3-4) which requires no PC connection, or

by using the VisiSet™ Setup Wizard (steps 5-6). Select the procedure
NOTE according to your needs.

STEP 3 - AIM THE READER

Matrix 210™ provides a built-in aiming system to aid reader positioning. The aiming system
is accessed through the X-PRESS™ Interface.

1. Power the reader on. During the reader startup (reset or restart phase), all the LEDs blink
for one second. On the connector side of the reader near the cable, the “POWER ON”
LED (blue) indicates the reader is correctly powered.

2. Enter the Aim/Locate function by pressing and holding the X-PRESS™ push button until
the Aim LED is on.

3. Release the button to enter the Aim function. The aiming system turns on see Figure 6.

Place the application specific code in front of the reader at the reading distance indicated
for your model in the Reading Features table, centering it in the aiming system indicator.

default value for: FOV
NEAR, MEDIUM,
FAR models @ green “EA‘_’Ym
00D
green D
TRIGGER s
yellow @ Uy
default value for: FOV. =
UHD models yellow td
red

Figure 6 — Aiming Function Using The Blue Ring or Figure 7 — X-PRESS™ Interface: Aim Function
Internal Lighting System *

* the default value of the Aiming System Status parameter can be changed in VisiSet™.

5. Exit the Aim function by pressing the X-PRESS™ push button once. The aiming system
turns off.
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STEP 4 - X-PRESS™ CONFIGURATION

Once Matrix 210™ is positioned with respect to the code (step 3), you can configure it for
optimal code reading relative to your application. This configuration can be performed either
through the X-PRESS™ Interface or the VisiSet™ configuration program.

Setup

1. Enter the Setup function by pressing and holding

the X-PRESS™ push button until the Setup LED is
on.

. Release the button to enter the Setup function.
The Setup LED will blink until the procedure is
completed.

The Setup procedure ends when the Image
Acquisition parameters are successfully saved in
the reader memory, the Setup LED will remain on
continuously and Matrix 210™ emits 3 high pitched
beeps.

If the calibration cannot be reached after a timeout
of about 5 (five) seconds Matrix 210™ will exit
without saving the parameters to memory, the
Setup LED will not remain on continuously but it will
just stop blinking. In this case Matrix 210™ emits a
long low pitched beep.

3. Exit the Setup function by pressing the X-

PRESS™ push button once.

Learn

4. Enter the Learn function by pressing and holding

the X-PRESS™ push button until the Learn LED is
on.

. Release the button to enter the Learn function.
The Learn LED will blink until the procedure is
completed.

The Learn procedure ends when the Image
Processing and Decoding parameters are
successfully saved in the reader memory, the
Learn LED will remain on continuously, the Green
Spot is activated and Matrix 210™ emits 3 high
pitched beeps”.

If the calibration cannot be reached after a timeout
of about 3 (three) minutes Matrix 210™ will exit
without saving the parameters to memory, the
Learn LED will not remain on continuously but it will
just stop blinking. In this case Matrix 210™ emits a
long low pitched beep.

6. Exit the Setup function by pressing the X-

PRESS™ push button once.

! The Learn procedure will not recognize Pharmacode symbologies.

READY
green

G0OD

green .@
TRIGGER (13

yellow . -
coMm kie

yellow (R rest) !
STATUS

red . . ‘

Figure 8 — X-PRESS™ Interface
Function

READY

green ‘O S
00D
TRIGGER s
yellow OED I
oM =
yellow .@ =
STATUS
red 0 i

Figure 9 — X-PRESS™ Interface
Function

: Setup

: Learn
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@ If you have used this procedure to configure Matrix 210™ go to step 7.
NOTE

RESET READER TO FACTORY DEFAULT (OPTIONAL)

If it ever becomes necessary to reset the reader to the factory default values, you can
perform this procedure by holding the X-PRESS™ push button pressed while powering up
the reader. You must keep the X-PRESS™ push button pressed until the power up
sequence is completed (several seconds) and all LEDs blink simultaneously 3 times.

All LEDs remain on for about 1 second, then off for one second, the Configuration and
Environmental parameters are reset, and the status LED remains on. If connected through a
CBX500 with display module, the message "Default Set" is shown on the display.
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STEP 5 - INSTALLING VISISET™ CONFIGURATION PROGRAM

VisiSet™ is a Datalogic reader configuration tool providing several important advantages:

e Setup Wizard for rapid configuration and new users;

e Defined configuration directly stored in the reader;

¢ Communication protocol independent from the physical interface allowing to consider the
reader as a remote object to be configured and monitored.

To install VisiSet™, turn on the PC that will be used for the configuration, running
Windows 98, 2000/NT, XP, Vista, 7 or 8, then insert the VisiSet™ Mini-DVD, wait for the
DVD to autorun and follow the installation procedure.

This configuration procedure assumes a laptop computer, running VisiSet™, is connected to
the reader's auxiliary port.

After installing and running the VisiSet™ software program the following window:

Press <Connect> to configure the reader.

Cormection: none, Readsr Status: NOT CONNECTED Lig : OFF

Figure 10 - VisiSet™ Opening Window
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Set the communication parameters from the "Options" menu. Then select "Connect", the
following window appears:

File Edit Connect Disconnect Device Options Tools  Help

MATH MENU

| M. Setup Wizard

Communication Port: Auxiliary
F. Calibration Tool

Standard Application Program for Matrix Family Rel. 6.10
V. Symhbol Verification |

A. Run Mode

B. Capture Image

C. Decode Last Image

D. View Last Image

E. Download Last Image

H. Upload Bitmap Image

Q. Image Buffer

3. Button Function Menu

Connection: Def_Matrix on 172,27, 101,81 Reader Status: OFF LIME MODE Log : OFF

Figure 11 - VisiSet™ Main Window After Connection

STEP 6 - CONFIGURATION USING SETUP WIZARD

The Setup Wizard option is advised for rapid configuration or for new users. It allows reader
configuration in a few easy steps.

1. Select the Setup Wizard button from the Main menu.

B Setup Wizard, Elﬁ“z‘ 5 Setup Wizard

Top.Left

1. Positioning Send Defaults

Calibration Mode

2 Calibration @ Change Exposure Time And Gain [Static Made]
" Change Gain Only

Capturs Image Code Setting Mode
3 Code Sating & fddd Hew Symbolagy

|  Replace Cunent Symbalogies
. Battam,Right g Saving Options

Image Acquisition Information ! £~ Famaen Memen

Acquisition Setting: !

& Temparary Memory

Setup Result

Decoding Results

Symbolagy Selacted Cade ft JJ
Code Data

Code Center:

Image Lighting Guality

THIRK:

J Close

Place the application specific code in front of the reader at the correct reading distance
(see step 2 and the Reading Features table in the chp. 7).

10



RAPID CONFIGURATION

2. Press the "Positioning" button. The reader continuously acquires images and gives visual
feedback in the view image window. The Setup Wizard now shows four delimiters (red
points) in the acquired images which indicate the region in which the calibration algorithm
is active. Move the reader (or code) to center it.

Press the Positioning button again to stop positioning.

M Setup Wizard
Top.Left

S

~Image Acquisition Information:
Acquisition Setting: 1
Exposure Time (x10us]: 400
Gain 12
Decoding Results:
Symbology:
Code Data:
Code Center.

|~ Image Lighting Quality

Bottom Right
Self Tuning: Dizabled
: 2t |
Selected Code: =
To/BE—

m Close

x| H Setup Wizard,

-Setup Result

Calibration Mode
@ Change Exposure Time And Gain [Static Mode)
£ Change Gain Only

Code Selting Mods:
& held New Symbology
" Fieplacs Curent Symbologies

Sawing Options
" Pemmanient Memary
& Temporary Memary

3. Select a Calibration Mode choice and press the "Calibrate" button. The reader flashes
once acquiring the image and auto determines the best exposure and gain settings. If the
code symbology is enabled by default, the code will also be decoded.

EE Setup Wizard

Top.Left

gli\- | B‘a Setup Wizard

Image Acquisition Information

Acquisition Sething: 1
Exposure Time [10us]: 160
Gain: 12
Decoding Results

Symbalagy:

Code Data.

Code Center:

Exposure Index;

Image Lighting Guality

J

Underexposed

oK

Owerexposed

Caphure Image
View Image

Self Tuning: Enabled

Status: Completed
=1

Selscted Code: i &

Lighting Index:

THIRH

] ‘ Close

. Doninad mags
Bottam Right

1. Positioning

3
|

2. Calibration

3. Code Sefting

4 Save

Setup Result

Send Defaults

~Calibration Mode

& Change Exposuie Time Ard Gain (Static Mode]
 Change Giain Orly

Code Setting Mods
& Add Mew Symbology
" Replace Cunent Symbologies

Saving Options
" Permanert Meman

@ Temporamy Memory

Calibration procedure in progress ...

Calibration procedure completed using Image Acquisition
Setting #1.

New Exposure Time (x10us): 160

Wew Gain ¢ 12

11
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4. Select a Code Setting Mode choice and press the "Code Setting" button.

The Setup Result section of the Setup Wizard window shows the code type results and
the parameter settings.

EB Setup Wizard,

Top.Left

1. Positioning Send Defaults

~Calibration Mode

2 Calibration @ Change Exposure Time And Gain [Static Made]
" Change Gain Only

Captu,e - Code Setting Mods
4 3 codessting & Add Mew Symbalogy
View Image S " Replace Curent Symbologies
Duwmuad \mage
Baitom Right Saving Dptions

Image Acquisition Information ! T £~ Famaen Memen
Acquisition Setting: 1 Self Tuning: Disabled

& Temparary Memory

Exposure Time (1 Dusk 160
i 12 Setup Result
Decoding Results o
bl Dista Mty ECC 200 Selected Code T4 Eode: SECTING ProceduEe INODEOUERSS pane
Code Data. Datalogic 20 Code Reader Code Setting procedure completed: 1 code(s) found.
Code Center: (X,¥]=(372,241) Code Symbologies:
- 1. Data Matrix ECC 200
EDdE_D"E”[ahD" i H Hialioria Processing Mode ! Adwanced Code Setting Setu Result
Image Lighting Guality Rectangular Formats : Disabled p

Data Matrix Module Size: 11 mils

Exposure Index: Lighting Index: Code Color : Black
Underexposed ok Oweresposed Image Mirroring i Disabled
Code Contrast (2D) : Standard
THIRE: Decoding Method : Standard

J Close -

5. Select a Saving Options choice and press the "Save" button.

1. Positioning Send Defaults

~Calibration Mode-

S aibratan ¥ Change Exposure Time And Gain (Static Made]
" Change Gain Only

Code Setting Mode

3. Code Seting & Add Mew Symbology

" Replace Curent Symbologies

Saving O ptions

(s Peimanent Memary ‘_

 Temporary Memory

TEtup mEsuT

Code Setting procedure completed: 1 code{s) Eound. ”~
Code Symbologies:
1. Data Matrix ECC 200

Processing Mode i Adwanced Code Setting
Rectangular Formats : Disabled

Data Matrix Module Size: 11 mils

Code Color Black

Image Mirroring Disabled

Code Contrast (2D) 1 Standard

Decoding Method : Standard

Checking configuration...0E
Configquration saved in Permanent memory!

6. Close the Setup Wizard.

If your application has been configured using the VisiSet™ Setup Wizard,
your reader is ready. If necessary you can use VisiSet™ for advanced

NOTE reader configuration.
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STEP 7 — TEST MODE
Use a code suitable to your application to test the reading performance of the system.
Alternatively, you can use the Datalogic 1D/2D Test Chart (Code 39, Data Matrix ECC 200).

1. Enter the Test function by pressing and holding the X-PRESS™ push button until the
Test LED is on.

2. Release the button to enter the Test function.
Once entered, the Bar Graph on the five LEDs is activated and if the reader starts

reading codes the Bar-Graph shows the Good Read Rate. In case of no read condition,
only the STATUS LED is on and blinks.

READY

green D
GOOD

green =0
TRIGGER 3

yellow 4/
oM

yellow .@
STATUS

red .‘ A

Figure 12 — X-PRESS™ Interface: Test Function

3. To exit the Test, press the X-PRESS™ push button once.

@ By default, the Test exits automatically after three minutes.
NOTE

The Bar Graph has the following meaning:

2 95%

>75%

TRIGGER (13
T eaD -
coMm =
2 40% oD -
STATUS
> 20% S) &

Figure 13 — Test Bar Graph
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ADVANCED READER CONFIGURATION

For further details on advanced product configuration, refer to the VisiSet™ Help On-Line.
The following are alternative or advanced reader configuration methods:

Advanced Configuration Using VisiSet™

Advanced configuration can be performed through the VisiSet™ program by selecting
Device> Get Configuration From Temporary Memory to open the Parameter Setup window in
off-line mode. Advanced configuration is addressed to expert users being able to complete a
detailed reader configuration. The desired parameters can be defined in the various folders
of the Parameter Setup window and then sent to the reader memory (either Temporary or

Permanent):

Fle Edit Connect Disconnect Dewice Options Tools Help

-
HATH MENU H Parameter Setup

Device: Matrix EECSSVICNGSLLY

M. Setup Wizard Model: 211-100

(TOMMERNERE Y Gt | Send | SendDefaults [ | Pemanent || interactive |

F. Calibration Tool
V. Symhol Verification
A. Run Mode

Operating Modes | Calibration

IR INEWANNERY 20 Codes | 1D Codes | PostalCodes | Image Processing | Miscelaneous |
Feading System Layout | CBHGateway | Disphy | Diagrostics

Data Collzction i Match Cods | SymbolYerfication | Communication

|
| Digtsll/0 | LEDsAndKeypad |
|

B. Capture Image CODE COLLECTION

Murnber Of Codes
C. Decode Last Inage

1

Digabled

| DATA FORMAT
E. Download Last Iimage

Disabled

Code Field Cutting

Dizabled

Cade Field Justification
H. Upload Bitmap Image

Mo Read Message

<245

Data Packet Format

%2 %

G. Store Match Code

Statistics Field Separator Stiing

<1310

. Cade Callection Filters
D. View Last Image

. Image Buffer

Statistics Field Famat

%1

Symbology | dentifiers

3. Button Function Menu

Digabled

STATISTICS

Status

Disabled

{Connection: COB012005 on COM1 ak 115200,N,5,1 Reader Status: OFF LINE MCDE

Log : OFF

Figure 14 - VisiSet™ Parameter Setup Window

Host Mode Programming

The reader can also be configured from a host computer using the Host Mode programming
procedure, by commands via the serial interface. See the Host Mode Programming file on

the Mini-DVD.

Alternative Layouts

If you need to install an Ethernet network, ID-NET™

network, Fieldbus network, Pass-

Through network, Multiplexer network or an RS232 Master/Slave refer to the Matrix 210™

Reference Manual.

The reader can also be setup for alternative layouts by reading programming barcodes. See
the "Setup Procedure Using Programming Barcodes" printable from the Mini-DVD.

Code Quality Verification

Matrix 210™ can be used as a Code Quality Verifier according to the ISO/IEC 15415,

ISO/IEC 15416, AS9132, and AIM DPM Standards.

14
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2 INTRODUCTION

2.1 PRODUCT DESCRIPTION

Matrix 210™ is the new Datalogic 2D reader offering excellent reading performance, ultra
compact size and extreme ease of use. Thanks to innovative optical features, advanced
software functions and complete connectivity options, Matrix 210™ s the cost effective
solution for applications where the space is very limited.

Ultra Compact Size
Compact dimensions, straight and 90° reading window models availability allow flexible
mounting and positioning in narrow spaces.

Excellent Reading Performance

WVGA image sensor, up to 60 frames/s acquisition rate and dynamic reading capability,
together with powerful decoding libraries provide excellent performance on a wide range of
code symbologies as well as damaged and low quality codes. Matrix 210™ allows reading
10 mils codes in moving applications at speeds up to 2 m/sec.

Innovative Optical Features

The innovative optical and lighting systems ensure wide field of view at short reading
distances, combined with excellent illumination pattern. Matrix 210™ has a maximum
reading distance of 200 mm, and it can read at near distance ultra high density 2D codes up
to 0.076 mm (3 mils).

Ease Of Use

The intuitive X-PRESS™ Human Machine Interface makes installation and maintenance
easier than ever thanks to a five LED bar graph and the multi-function key providing
immediate access to relevant functions such as Aiming, Setup (for automatic imager
calibration), Learn (for automatic code setting), Test Mode (for bar graph activation). A Green
Spot provides immediate Good Read feedback.

Enhanced Connectivity
An embedded high speed ID-NET™ communication interface allows efficient data collection
and simplifies network wiring. USB interface models allow direct connection to a PC.

Industrial Features
Matrix 210™  with its rugged construction, IP65 protection class, 50°C max operating
temperature and 10 to 30 VDC power supply is the ideal product for industrial applications.

15
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Matrix 210™ has been developed for use in numerous industries like:

Electronics:
= PCB Board Tracking
= Electronics Product Tracking

Pharmaceutical & Chemical:
= Medical Devices Traceability
* Pharmaceutical and Medicine Manufacturing

OEM:

=  Chemical & Biomedical Analysis Machines
Access Control Systems

Self Service Systems (ATM, Kiosks)

Print & Apply systems

Document Handling

This technology intrinsically provides omni-directional reading.

Standard Application Program

A Standard Application Program is factory-loaded onto Matrix 210™. This program controls
code reading, data formatting, Ethernet interfacing, serial port and USB interfacing, and
many other operating and control parameters. It is completely user configurable from a
Laptop or PC using the dedicated configuration software program VisiSet™, provided on
Mini-DVD with the reader.

There are different programmable operating modes to suit various code reading system
requirements.

Quick, automatic positioning, calibration and code setting of the imager can be accomplished
using the X-PRESS™ button and LEDs on top of the reader without the necessity of a PC.

The previous functions can also be performed through VisiSet™ through the Setup Wizard.
This tool includes visual feedback from the reader.

VisiSet™ provides a Calibration Tool to verify the exact positioning of the reader and to
maximize its reading performance.

Statistics on the reading performance can also be visualized through a dedicated window in
VisiSet™.

Symbol Verification can be performed through VisiSet™ when the reader has been installed
and setup as a Verifier station.

Programmability

If your requirements are not met by the Standard Application Program, Custom Application
Programs can be requested at your local Datalogic distributor.
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Some of the main features of this reader are given below:

Ultra Compact Dimensions

Direct and 90° window models for smart mounting
Outstanding decoding capability on 1D, 2D, Stacked and Postal symbologies
High performance on dynamic reading applications
X-PRESS™ for easy and intuitive setup

Optical Aiming System

10 to 30 VDC Power Supply

High Speed Ethernet Connectivity

USB Connectivity

ID-NET™ embedded high speed connectivity
Region Of Interest Windowing for higher frame rate

Run Time Self Tuning for higher flexibility

17
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2.2 INDICATORS AND KEYPAD BUTTON

Figure 15 - Indicators

®

The following LED indicators are located on the reader:

NET For Ethernet models, on the connector side of the reader near the Ethernet
connector, the orange ETHERNET NETWORK PRESENCE LED indicates the
on-board Ethernet network connection. (Figure 15, 1)

PWR On the connector side of the reader near the cable, the blue POWER ON LED
indicates the reader is correctly powered. (Figure 15, 2)

In normal operating mode the colors and meaning of the five LEDs are illustrated in the

following table:

READY green LED indicates that the reader is ready to operate (Figure 15, 3)

GOOD green LED confirms successful reading (Figure 15, 4)

TRIGGER |yellow LED indicates the status of the reading phase (Figure 15, 5)

CcoM yellow LED indicates active communication on the main serial port * (Figure 15, 6)
STATUS red LED indicates a NO READ result (Figure 15, 7)

* When connected to a Fieldbus network through the CBX500, the COM LED is always active, even in the
absence of data transmission, because of polling activity on the Fieldbus network.

During the reader startup (reset or restart phase), these five LEDs blink for one second.

In X-PRESS™ Configuration mode the colors and meaning of these five LEDs are described

in par. 2.4.

The keypad button (Figure 15, 8, is software programmable. By default it starts the X-
PRESS™ interface for quick installation without using a PC (see chp. 1).
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2.3 ID-NET™

The ID-NET™ network is a built-in high-speed interface dedicated ™
for high-speed reader interconnection. ID-NET™ is in addition to
the Main and Auxiliary serial interfaces. ID NET

The following network configurations are available:

» |ID-NET™ M/S Synchronized: Single station — multiple readers

CEX100 CBX100

ID NET"

ID-NET™ interface allows local connection of multiple readers reading different sides of the
same target. All readers share a single presence sensor and activate/deactivate

simultaneously.
At the end of each reading phase a single data message is transmitted to the host.

Thanks to ID-NET™, data communication among readers is highly efficient so that an
immediate result will be available.

19
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= |ID-NET™ M/S Multidata: Multiple stations — single reader

CBX100 CBX100

ID NET”

ID-NET™ interface allows connection of readers reading objects placed on independent
conveyors. All readers are typically located far away from each other and they use a
dedicated presence sensor.

At the end of each reading phase, each reader transmits its own data message to the host.
Thanks to ID-NET™, data collection among readers is accomplished at a high speed without
the need of an external multiplexing device. This leads to an overall cost reduction and to a
simple system wiring.

2.3.1 How To Setup/Configure the Reader Network

A complete ID-NET™ reader network can be easily setup through VisiSet™ as follows:

Mounting & Connection

1. Mechanically mount/install all the readers (refer to par. 3.2 and 3.3).
2. Wire ID-NET™ (refer to par. 4.3 or 5.5).
3. Power up the entire system.

Configuration of Slaves

1. Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Slave reader.

Launch VisiSet™ and connect to the Slave reader.
From the VisiSet™ Device Menu select "Parameter Setup".

Set the Role of the Slave reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

5. Set the Slave Address according to the desired value 1-31 from the
Reading System Layout > Device Network Setting > Slave Address parameter. Each
reader must have a different Address on the ID-NET™ Network.

6. If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).
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Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

The Slave device is now Configured. Physically connect it to the Master/Slave network. If
using the CBX connection box equipped with a BM100 Backup module, you can perform
Device Backup at the Slave (see par. 2.4 for details).

Repeat these steps for each Slave reader in the ID-NET™ network.

Configuration of Master

1.

Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Master reader.

Launch VisiSet™ and connect to the Master reader.
From the VisiSet™ Device Menu select "Parameter Setup".

Set the Role of the Master reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

Enable the planned Slave device N from the Reading System Layout >
Expected Slave Device #N > Status parameter and, if desired, set the related
identification string from the Expected Slave Device #N > Device Description parameter.
Repeat this step for all planned Slave devices.

If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).

Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

The Master device is now Configured. Physically connect it to the Master/Slave network.
If using the CBX connection box equipped with a BM100 Backup module, perform a
Network Backup at the Master (see par. 2.4 for details).

From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices
within the ID-NET™ network.

I_S-h:n Devicer -NHI_'-'M S'-ewhﬂg_] Blackup o Nebwork |
[Shave Addiess 'F'rm:reé'%'u;u=|c'u-cfi Stou Ii}u&'e'a'nwfm i ii:l-n'aiuunim !'F'*um'a:;] ~
E rabiad Prezent Mgt 210 C10P0N 554 Get
|12 Erabéed Pregent Mt 210 Ci0PON548 Gt
!1 Enabled Present Mt 210 CloFn&52 Gt
C Enebled Presend Mok 210 C10PONSSD Get
EE Erablad Prassn Matme 210 CI0PMES51 Gt
EE Erabled Prazent Mt 210 CloPM 53 Gt
7 Ensbisd Present Matix 210 C10POTBE Get

Ext

The reader network is ready.
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ID-NET™ Slave Management Through Master

When an ID-NET™ layout has already been configured, it is possible to modify the
configuration of any Slave from VisiSet through the Master.

1. Connect a PC equipped with VisiSet™ to the Main, or Auxiliary interface of the Master

reader.

Launch VisiSet™ and connect to the Master reader.

From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices
within the ID-NET™ network.

4. Click anywhere in the row of the specific slave in the ID-NET Status Window when its
Current Status is "Present". The Parameter Setup window will be displayed after a time
based on the network speed, with the configuration of the selected slave.

5. From the specific Slave Parameter Setup Window, change any parameter (not in
interactive mode), save the configuration to a file, or load a configuration from a file.

6. Send the modified configuration to the slave.

(5 Parameter Setup Slave# 2
File L[ Viod
[ _send | _senapetous | [ _imeracive |
20 Codes ] 10 Codes | Fostal Codes ] Image Froceszsing ] Mizcellaneous |
Data Collection ] katch Code | Symbol Yerfication ] Communication ]
Reading System Layout | ticroglyph Codes | CBx Gatewan ] Dizplay | Diagnostics |
O perating Modes Calibration | Digal 140 | LEDsAndKeppad |
|EIF'EF|.*3.TINI3 MODE
| Operating Mode Phaze Mode
Reading Phase OM Eut. Trig. Leading Edge
Acquizition Trigger Continuous
Mumber Of Acouizition ]
Acquizition Trigger Status Alwaysz Enabled
Reading Phaze OFF Ext. Trig. Trailng Edae
Image Acquisition Buffer Size 10
| Acquizition Retry Dizabled
ACOUISITION TRIGGER DE L&y 1
Status Enabled
Drelay Time [2100uz] Ba0
If a wrong configuration is set or if the Slave Reading System Layout
parameters are changed, the slave could lose the network connection.
CAUTION
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24 EXTERNAL MEMORY BACKUP AND RESTORE THROUGH
VISISET™

The "External Memory Backup" or "External Memory Restore" functions allow performing
Complete Configuration and Environmental parameter storage for network and reading
devices. Backup & Restore can be applied to any reader connected through a device having
External Backup Memory, regardless of the reader's network configuration. Backup &
Restore automatically checks whether a previous backup or configuration is already available
for each device, speeding the procedure up and making it more secure.

These functions are supported by VisiSet™ for all reading devices having sw 6.10 and later
when connected to:

e CBX + BM100 and/or BM2x0 (sw release 2.02.01 and later)
e QL500 (Ethernet TCP/IP) (sw release 2.02.01 and later)

o QLM-Series Gateways (reading device sw release 6.50 and later)

e Before executing a Backup on a BM100 backup module make sure the Write
Protection switch is set to Unlocked.

e If BM100 and BM2x0 are both installed B&R is automatically performed only on

@ the BM100 module.
BM2x0 can execute B&R only with Network up and running (network cable
NOTE connected).
e  QL500 can backup up to 10 nodes (Master + 9 slaves).
Backup

To perform a Backup:

1. Select "External Memory Backup" from the VisiSet™ Device menu

2. You will be warned that the previous backup will be overwritten. Confirm by clicking Yes.

Eﬂ Confirmation @

Start Configuration Backup?

121d bhackup will be owenwtitten)
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The VisiSet™ Main window shows information as the backup procedure is performed and a

message indicating successful completion.

Fis Edt Conrect Disconnect Device Optiors Took Help

MAIN MENU
Device: Matrix 210

Hodel: Unknown
Communication FPort: Ethernet

ML Setup Wizard
F. Calitw ation Tool

MACHUM: 00:07:BE:D1:02:09
DHCPF disahled.

V. Syrnibod Ver i ation
A. Rumn Moda

B, Caglune W Cateway: 172.27.2.254

DHS1: 172.27.0.32
C. Decods Last mage

D. Last knage Backing up Slave 1...

E. Dowmboad Last hnage

Backup modules updated?
H. Upbo sl Bftiuap lmage
. lmawge Bafler

3. Buitton Fumctbon Menu

LConnection: Def _Matri on 172.27.101 61 Fesader Stabus: OFF LINE MODE

Standard Application Program for Matrix Family Rel. 6.10

IP Address: 172.27.101.81
Subnet Mask: 233.233.0.0

Backing up local device {Master)...
Local devicoe {(Master) successfully backed up

Slave 1 successiully backed up

External Memory Hackup procedores successfully completed.

Log : OFF

Restore

To perform a Restore:

1. Select "External Memory Restore" from the VisiSet™ Device menu

2. You will be warned that the current device configuration(s) will be overwritten. Confirm by

clicking Yes.

m Confirmation

Start Configuration Restore?

(Current configuration in dewvice will be oweannritten)

XND|
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The VisiSet™ Main window shows information as the restore procedure is performed and a
message indicating successful completion.

Fle Edt Connect Dicornect Device Opbiors Tools Help

MAIN MHENU

. Symnibol Vier mfication
A Fum Mo

B. Captimé knage

C. Decods Last nage
0. View Last image

E. Download Last linage

Updoad Bitrmap Bnage

O, e BifTed

1. Batton Fumction Man

Conrection: Def _Matric on 172.27.101.81

Device: Matrix 210
Model: Unknown
Comminication Port: Ethernet

Standard Application Program for Matrix Family Rel. 6.10
MACHUM: 00:07:BE:D1:02:09
DHCP disabled.
IP Address: 172.27.101.81
Subnet Mask: 5.255.0.0
Gateway: 1
PHS1: 172.27.0.32
Regtoring loocal device {(Magter)...
Local device (Master) successfully restored
Cheocking configuration...0K
Configuration saved in Fermanent memory |

Loacal device updated!
Checking for ID-NET Slaves...
Restoring Slave 1...
S5lave 1 succesgfully restored

External Hemory Restore procedure successfully completed.

Feader Fobus: OFF LINE MODE Leg ; OFF

Replacement

The External Memory Restore function also provides easy and secure Single Device

Replacement:

1. Remove the device to be replaced

Connect the new device (make sure the new device has been previously set to default)

Run the Restore procedure by selecting the "External Memory Restore" item (see:

Restore procedure)
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Erase

To Erase any previous Backup:

1. Select "External Memory Erase" from the VisiSet™ Device menu

2. You will be warned that all device configurations in the current backup will be erased.
Confirm by clicking Yes.

EE Confirmation

Any Configuration present in current Backup will be erased

Are you sure yvou wantto proceed?

L o Yes X Mo

The VisiSet™ Main window shows a message indicating successful completion.

Fie Edt Connect Deornect Device Opbions Tools Help

HAIH MEHU

oe: Matrix 210
: Unkcrnowmn
Communication Fort: Ethernet

M. Setup Wirand

F. Calibi ation Tool
Standard Application Program for Matrix Family Rel. 6.10
MACHIM: 00:07:BE:01:02:09
DHCP disabled.
IP Address: 172.27.101.81
Subnet Mask: 255.255.0.0
Gateway: 172.27.2.254
DHS1: 172.27.0.32
Hackup module erased!
Extornal Memory Erase procedure sucoessfully completed.

V. Symibial Vi Bication
A, Fum Mode
B. Caplime image

C. Decods Last nage

0. View Last Image

E. Dowidoad Last nage

E

Bitriags bnadge
O, brriaw(e BaTe

1. Baston Function Mena

Connmction: Def _Matric on 172.27.101 81 Feader Rabys: OFF LINE MODE Leg § OFF
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List

To see a List of the current Backup:

1. Select "External Memory Read Backup" from the VisiSet™ Device menu.

The VisiSet™ Main window shows a list of devices in the current Backup.

Fiia Edt Connect Discornect Device Optiors Took Help

HMALIN HMEHU

: Hatrix 210
L:  Unkrowmn
Communication Port: Ethernet

ML Séstup Wizand

F. Calii ation Tool
Standard Application Program for Matrix Family Rel. 6.100

MACNUM: 00:07:BE:DL:02:09
DHCP disahled.
IF Address: 172.27.101.81
fubnet Mask: 255.255.0.0
Gateway: 172.27.2.254
DMS1: 172.27.0.32
Ligt of backup pressnt on External Memory
MASTER:Matrix 210
SLAVE 1:Matrix 410

V. Symibol Vet Mication
A Fum Mo

B. Caplure mage

C. Decods Last inage

D View Last Image

E. Dowidoad Last Miage

H. Upload Bitmap inadge

O, bnadge BafTer

1. Buston Fussction Maena

sConnection: Def_Matrtc on 172.27,101.81 Reader Sabus: OFF LINE MODE Lo : OFF

The following is a list of possible error messages displayed on the VisiSet™ main window in
case of an External Memory function failure:

e Module not present: backup module not mounted (BM100) or not ready (QL500,
BM2x0)

¢ Unable to Read Backup State: VisiSet™ is unable to connect to the backup memory

e Backup function not allowed: when device is in X-PRESS™ Menu mode (BM100,
QLM) or is out of memory (QL500)

o Failed! (Device not found): Master is unable to reach the addressed device
o Failed! (Module is write protected):. BM100 Write Protection switch is set to Locked
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2.5 X-PRESS™ HUMAN MACHINE INTERFACE

X-PRESS™ is the intuitive Human Machine Interface designed to improve ease of
installation and maintenance.

Status information is clearly presented by means of the five colored LEDs, whereas the
single push button gives immediate access to the following relevant functions:
e Learn to self-detect and auto-configure for reading unknown codes.

e Setup to perform Exposure Time and Gain calibration.

e Aim/Locate to turn on the blue ring to aid positioning.

1)
n
1]
e
=

‘ml‘ﬁriau'

e Test with bar graph visualization to check static reading performance.

v
A

)

2.5.1 X-PRESS™ Functions

Quick access to the following functions is provided by
an easy procedure using the push button:

1 — Press the button (the Status LED will give a
visual feedback).

2 — Hold the button until the specific function LED is
on (Test, Focus, Setup or Learn).

3 — Release the button to enter the specific function.

Once button is pressed, the cycle of LEDs activation is as follows:

READY

GOOD

TRIGGER

READY

GOOD

TRIGGER

{Press
press
pPress

‘mrz‘-rlaro

o ]
B B
i T
o 1]
£ £
— -

)i
K
K

Qf;}ws A

;.-Z:'ngTUS A

> > >
Release button Release button Release button
to Exit to enter Test Mode to enter Aim/Locate Mode
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READY READY

g LEARN 9 D

GOOD GOOD

O EED o@D .

TRIGGER 3 TRIGGER ﬁ;

@@ C: @D g

.%f;}nus A gf{érus A

> 2> = (cycle)

Release button Release button Release button
to enter Setup Mode to enter Learn Mode to Exit

Test Mode (Function 1)

Once entered, the Bar Graph on the five LEDs is activated and if the imager starts reading
codes the Bar-Graph shows the Good Read Rate. In case of a NO READ condition, only the
Status LED is on and blinks.

The Bar Graph has the following meaning:

READY

T 6 e
GOOD

275% o &=D
TRIGGER ng

T e
oM

> 40% oD
STATUS

>20% @ A,

To exit the Test Mode, press the X-PRESS™ push button once.

@ By default, the Test exits automatically after three minutes.
NOTE

Aim/Locate (Function 2)

This function causes the blue ring to turn on. Since the blue ring is centered on the FOV it
can be used to position the imager on the code. The Aim LED blinks to indicate this state.

To exit the Aim/Locate Mode, press the X-PRESS™ push button once. The blue ring turns
off.
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Setup (Function 3)

Once entered, the imager automatically performs Image Acquisition parameter calibration for
the specific code presented to it.

The Setup LED will blink until the procedure is completed.

The Setup procedure ends when the Image Acquisition parameters are successfully saved in
the reader memory, the Setup LED will remain on continuously and Matrix 210™ emits 3 high
pitched beeps.

If the calibration cannot be reached after a timeout of about 5 (five) seconds Matrix 210™ will
exit without saving the parameters to memory, the Setup LED will not remain on continuously
but it will just stop blinking. In this case Matrix 210™ emits a long low pitched beep.

Learn (Function 4)

Once entered, the imager starts a procedure to automatically detect and recognize codes
which are presented to it.

The Learn LED will blink until the procedure is completed.

The Learn procedure ends when the Image Processing and Decoding parameters are
successfully saved in the reader memory, the Learn LED will remain on continuously and
Matrix 210™ emits 3 high pitched beeps.

If the calibration cannot be reached after a timeout of about 3 (three) minutes, Matrix 210™ will
exit without saving the parameters to memory, the Learn LED will not remain on continuously
but it will just stop blinking. In this case Matrix 210™ emits a long low pitched beep.

2.6 MODEL DESCRIPTION

The Matrix 210™ reader is available in different versions according to the following
characteristics:

MATRIX 210 XXX-XXX

Sensor Size J \—V Options

2 =WVGA (752x480) 0 = Standard
1=ESD Safe
2 = ESD Safe + YAG CutFilters

n

lluminators » Interface

1 = Internal llluminator 0 = Serial
1 = Ethernet
2=USB

Focus Distance - » Reading Window

1 =Near 0=90°

2 = Medium 1 = Straight

3 =Far

4 =UHD
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2.7 ACCESSORIES

The following accessories can be used with the Matrix 210™ 21X-x0x and Matrix 210™ 21X-
x1x model readers.

Accessory Description Order No.
External llluminator
LT-700 Linear Array Lighting System 93A401028
BK-21-000 LT-700 Fixing Bracket 93ACC0052
Cables
CAB-ETH-MO01 M12-1P67 Ethernet Cable (1M) 93A051346
CAB-ETH-M03 M12-IP67 Ethernet Cable (3M) 93A051347
CAB-ETH-M05 M12-1P67 Ethernet Cable (5M) 93A051348
Connectivity
CBX100 Compact Connection Box 93A301067
CBX500 Modular Connection Box 93A301068
BM100 Backup Module for CBX100/500 93ACC1808
BM150 Display Module for CBX500 93ACC1809
BM200/BM210 Ethernet TCP/IP Module STD/IP65 for CBX500 93ACC1851, 93ACC1852
BM300/BM310 Profibus Module STD/IP65 for CBX500 93ACC1810, 93ACC1811
BM400 DeviceNet Module IP65 for CBX500 93ACC1814
93ACC1812, 93ACC1813,
BM500/BM510/BM520 EtherNet/IP Module STD/IP65/IP54 for CBX500 93AGC1840
BM600 CAN Open Module for CBX500 93ACC1815
BM700 Profinet IO Module for CBX500 93ACC1816
BM1100 CC-Link Module for CBX500 93ACC1845
BM1200/BM1210 Modbus TCP Module STD/IP65 for CBX500 93ACC1848, 93ACC1849
BA100 DIN Rail Adapters 93ACC1821
BA200 Bosch Adapters 93ACC1822
QL150 Quick Link Slave ID-NET + Service T-Connector 93ACC1868
QL300 Quick Link Master ID-NET - Serial Host Connector 93ACC1862
QL500 Quick Link Master ID-NET - Ethernet Host Connector 93ACC1864
QLM500 Quick Link Metal Master ID-NET - EtherNet/IP Gateway 93ACC0037
QLM600 Quick Link Metal Master ID-NET - Profibus Gateway 93ACC0033
QLM700 Quick Link Metal Master ID-NET - Profinet 10 Gateway 93ACCO0038
Power Supplies
PG6002 AC/DC Power Supply Unit (US) 93ACC1718
PG6001 AC/DC Power Supply Unit (UK) 93ACC1719
PG6000 AC/DC Power Supply Unit (EU) 93ACC1720
Sensors
MEP-593 Photocell Kit PNP (PH-1) 93ACC1791
MEP-543 Photocell Kit-NPN 93ACC1728
Matrix 210™ 21x-x2x models, (USB), are used for point-to-point
connections to PCs or USB Hubs and have no accessories.
NOTE
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2.8 APPLICATION EXAMPLES

Matrix 210™ is profitably used in the omnidirectional reading of 2D, stacked, linear and postal
codes for example in automated document handling and mail processing systems (see Figure 16).

Figure 16 - Address Coded in Data Matrix Symbology for Automated Mail Processing

Matrix 210™ assures the reading of deformed and / or overprinted codes, even though
damaged or printed on high reflective surfaces (see Figures 18, 19, 20).

Figure 18 - Overprinted Barcode Readable by Matrix 210™ also Through the Envelope Window Film

N

4

Figure 19 - Barcode Printed on Curved Surface Readable by Matrix 210™ in spite of Image Optical
Distortion
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Matrix 210™ is also very powerful in reading low-contrast direct part marked codes (see
Figures 21, 22, 23, 24 and 25).

Figure 20 - Dot Matrix Code Directly Marked on Metal Surface by Using Dot Peening Technology

o L /e
Figure 21 - Dot Peening Marking on Metal Surface with Multi-dot per Code Element

Figure 22 - Directly Marked Dot Matrix Code Characterized by Outstanding Separation Distance between
Adjacent Code Elements

1

D,

Figure 23 - Data Matrix Code Directly Marked on PCB Surface by Using Laser Etching Technology
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Gy
o

Figure 24 - Dot Matrix Code Directly Marked on PCB Copper Pad by Using Ink-Jet Technology

2.9 EXTERNAL LIGHTING SYSTEMS

In some direct part marking applications best reading results are obtained by using an
external lighting system.

The LT-700 Linear Array Lighting System provides a high intensity light source designed for
the following applications:

e with uneven, noisy and scratched surfaces

e where dot peening or laser etching codes are directly marked onto metal surfaces or
PCBs and need to be highlighted. Here the use of more than one LT-700 at different
positions can remove any shadowing effect.

e in the presence of highly reflective surfaces (metal, glass, etc.) causing direct reflections.
Low light path to surface angles strongly reduce direct reflections.

Figure 25 - LT-700 Linear Array Lighting System
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3 INSTALLATION

3.1 PACKAGE CONTENTS

Verify that the Matrix 210™ reader and all the parts supplied with the equipment are present
and intact when opening the packaging; the list of parts includes:

d Matrix 210™ reader

Quick Reference Guide

a

O  TestChart
a Matrix family Mini-DVD
a

Mounting Kit

¢ Mounting Screws (2)
¢ Washers (2)

e Mounting Bracket

Figure 26 - Package Contents
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3.2 MECHANICAL DIMENSIONS

Matrix 210™ can be installed to operate in different positions. The four screw holes (M3 x 4)
on the body of the reader are for mechanical fixture (Figure 27).

The diagram below gives the overall dimensions of the reader and may be used for its
installation.

Refer to par. 3.3 for various mounting solutions and correct positioning and chp. 7 for
Reading Distance considerations.

7 250 9.0
[0.29] [0.98] [0.36]

a[%‘? i /;/ " /] /
ik
\ \&f

c¥ o
<o Optical axis ~

32
[1.25]

[ ] R L mm
r [in]
g U
54
[2.13]
Figure 27 — Straight Model Overall Dimensions
7 25.0 o
[0.29] [0.98] |
? T i “ o
o®
Al \E'a
« S, » \ f
¢ U tical axis
o § 45
Ts E H [1.76]
O
TRIGEER & mm
= g [in]
”: A
j N STATUS
i |
6 | 50
[0.25] [1.97]

Figure 28 — 90° Model Overall Dimensions
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60°

30°

19
[0.75]
e
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39
[1.54]

2
[0.08]

i i Ao 1
12.5
[0.49] 05 64 J
e [2.52]
T T
//\
e 60°
\
< N\ .
\ 30
1=}
&2 g? N\ 262 n3
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2 3
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@
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Figure 29 - ST-336 Mounting Bracket Overall Dimensions
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Figure 30 - ST-337 Mounting Bracket Overall Dimensions
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3.3 MOUNTING AND POSITIONING MATRIX 210™

Using the Matrix 210™ mounting brackets you can obtain rotation on the various axes of the
reader as shown in the diagrams below:

:E: Tilt

Figure 33 —Mounting Bracket External Positioning
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Matrix 210™ is able to decode code labels at a variety of angles, however significant angular
distortion may degrade reading performance.

When mounting Matrix 210™, take into consideration these ideal label position angles: Pitch
or Skew 10° to 20° and Tilt 0°.

Note: Since Matrix 210™ is omni-directional on the code plane, the Pitch and Skew angles
have the same significance with respect to the code plane. However in some advanced code
reading applications performance can be improved by modifying the Pitch angle.

Follow the suggestions below for the best orientation:

The Pitch and Skew angles are represented by the values P and S in Figure 34 and in Figure
35. Position the reader in order to avoid the direct reflection of the light emitted by the Matrix
210™ reader; it is advised to assure at least 10° for one of these angles. In some cases, such
as low contrast or low illumination, it can be useful to use a Pitch or Skew angle = 0°.

P
iy il
Figure 34 - Pitch angle Figure 35 - Skew angle

The Tilt angle is represented by the value T in Figure 36. Matrix 210™ can read labels with

any tilt angle.

$

Minimize

Figure 36 - Tilt angle

See chp. 7 for FOV and Reading Distance considerations.
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4 CBXELECTRICAL CONNECTIONS

All Matrix 210™ 25-pin models can be directly connected to a CBX connection box.

We recommend making system connections through one of the CBX connection boxes since
they offer the advantages of easy connection, easy device replacement and filtered
reference signals.

¢

NOTE

If you require direct wiring to the reader the details of the connector pins
and relative connections are indicated in Chaper 5.

The table below gives the pinout of the CBX100/500 terminal block connectors. Use this
pinout when the Matrix 210™ reader is connected by means of the CBX100/500:

CBX100/500 Terminal Block Connectors

Input Power
Vdc Power Supply Input Voltage +
GND Power Supply Input Voltage -
Earth Protection Earth Ground
Inputs
+V Power Source — External Trigger
1A External Trigger A (polarity insensitive)
11B External Trigger B (polarity insensitive)
-V Power Reference — External Trigger
+V Power Source — Inputs
12A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V Power Reference — Inputs
Outputs
+V Power Source - Outputs
-V Power Reference - Outputs
O1+ Output 1 +
01- Output 1 -
02+ Output 2 +
02- Qutput 2 -
Auxiliary Interface
X Auxiliary Interface TX
RX Auxiliary Interface RX
SGND Auxiliary Interface Reference
ID-NET™
REF Network Reference
ID+ ID-NET™ network +
ID- ID-NET™ network -
Shield Network Cable Shield
Main Interface
RS485 RS485
RS232 Full-Duplex Half-Duplex
X TX+ RTX+
RX *RX+
RTS TX- RTX-
CTS *RX-
SGND SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.
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To avoid electromagnetic interference when the reader is connected to a
CBX connection box, verify the jumper positions in the CBX as indicated in
its Installation Manual.

NOTE

41 POWER SUPPLY

Power can be supplied to the reader through the CBX100/500 spring clamp terminal pins as
shown in Figure 37:

Power Supply

VGND
V+ Earth
in Ground

o || s | o | o | | || o

000000000

vde GND |, |REF I+ D- [g fsono T RS Rx cTs |
POWER % ID-NET % | MAIN RITX+ (RITX- RX+ RX-

Figure 37 - Power Supply Connections
The power must be between 10 and 30 Vdc only.

It is recommended to connect the device CHASSIS to earth ground (Earth) by setting the
appropriate jumper in the CBX connection box. See the CBX Installation Manual for details.

4.2 MAIN SERIAL INTERFACE

& Do not connect to the Main Interface spring clamp terminals if using Host
Interface Modules (Fieldbus) with the CBX500.
CAUTION

The signals relative to the following serial interface types are available on the CBX spring
clamp terminal blocks.

The main serial interface type and its parameters (baud rate, data bits, etc.) can be
defined by the user via VisiSet™ software. The RS485 half duplex is automatically set
whenever MUX32 communication protocol is enabled. For more details refer to the
"Communication" folder in the VisiSet™ Help On Line.

Details regarding the connections and use of the interfaces are given in the next paragraphs.
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421 RS232 Interface

The RS232 interface can be used for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The following pins are used for RS232 interface connection:

CBX100/500 Function
TX Transmit Data
RX Receive Data
RTS Request To Send
CTS Clear To Send
SGND Signal Ground

It is always advisable to use shielded cables. The overall maximum cable length must be
less than 15 m (49.2 ft).

USER INTERFACE
SGND RXD TXD

CTS RTS

| | —|

—1
REF D+ ID- |8 [senp Tx RTS RX cTs ‘

ID-NET % | MAIN (R)TX+ (R)TX- RX+ RX-

Ol

Vdc GND
POWER

Qll
Oll
< Olll

READER SGND TX RX
RTS CTS

Figure 38 — RS232 Main Interface Connections Using Hardware Handshaking

The RTS and CTS signals control data transmission and synchronize the connected devices.

START END
OF OF
gy TRANSMISSION TRANSMISSION
RTS
v —/— L/H
DATA DATA

|
I TRANSMISSION TRANSMISSION
|
|

+V

|
|
I
|
| |
[ TRANSMISSION [
I | STOPPED I
| |
| |

| |
ENABLED
+V —
-V

! | ENABLED
IDLE DISABLED IDLE

Figure 39 - RS232 Control Signals

If the RTS/CTS handshaking protocol is enabled, the Matrix 210™ activates the RTS output
to indicate a message is to be transmitted. The receiving unit activates the CTS input to
enable the transmission.
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4.2.2 RSA485 Full-Duplex Interface

The RS485 full-duplex (5 wires + shield) interface is used for non-polled communication
protocols in point-to-point connections over longer distances (max 1200 m / 3940 ft) than
those acceptable for RS232 communications or in electrically noisy environments.

The CBX pinout follows:

CBX100/500 Function
TX+ RS485 Transmit Data +
RX+ RS485 Receive Data +
TX- RS485 Transmit Data -
RX- RS485 Receive Data -
SGND Signal Ground

USER INTERFACE

RX485+ TX485+

SGND TX485-

| | —|

—] —

OO0
«5)5@/ SGND TX RTS RX CTS 1‘

o

REF ID+ ID-
ID-NET

Qll
@l
< Oll

Vdc GND

POWER % | man RTX+ RITX- RX+  Rx-

READER SGND TX+ RX+
TX- RX-

Figure 40 - RS485 Full-duplex Connections

@ For applications that do not use RX485 signals, do not leave these lines
floating but connect them to SGND as shown below.
NOTE

USER INTERFACE
RX485+

SGND M RX485-

| | —| | [

Ol0o o0

REF ID+ ID- [& [seno 1x RS Rx  cTs ‘

Ol

@l
o[l
< Oll

Vdc GND

POWER ID-NET /@/o MAIN (R)TX+ (R)TX- RX+ RX-

READER SGND TX+
TX-

Figure 41 - RS485 Full-duplex Connections using Only TX Signals
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4.2.3 RS485 Half-Duplex Interface

@ This interface is provided for backward compatibility. We recommend using
the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.
NOTE

The RS485 half-duplex (3 wires + shield) interface is used for polled communication
protocols.

It can be used for Multidrop connections with a Datalogic Multiplexer, (see par. 6.5) exploiting
a proprietary protocol based on polled mode called MUX32 protocol, where a master device
polls slave devices to collect data.

CBX100/500 Function
RTX+ RS485 Receive/Transmit Data +
RTX- RS485 Receive/Transmit Data -
SGND Signal Ground

USER INTERFACE
RTX485+

SGND RTX485-

o | | s || o | |  —|
REF D+ ID- | & ISGND TX RTS RX CTS
ID-NET % | man ®TX+ RTX- Rx+ Rx |1

O[l

Qll
ol
el

Vdc GND
POWER

READER SGND RTX+
RTX-

Figure 42 - RS485 Half-duplex Connections
This interface is forced by software when the protocol selected is MUX32 protocol.

In a Multiplexer layout, the Multidrop address must also be set via serial channel by the
VisiSet™ ultility or by the Host Programming Mode.

Figure 43 shows a multidrop configuration with Matrix 210™ readers connected to a
Multiplexer.

& This is an example of multidrop wiring. Consult the multiplexer manual for
complete wiring instructions.
CAUTION
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PG-6000

Reader
Slave
#0

Main Interf
MULTIPLEXER e— HOST
RS232/RS485
- 3 ay
120 Ohm % nultidrop 4
Multidrop +
Multidrop GND
Shield to Earth Shield
V-
V+
CBX100/50
: - RTX- A\
o |lls * 4+ RTX+
. B lShieId SGND
° . Tfloating| Shield
RS485 HD -
Termination Resistor. 0¥F
PG-6000

Reader
Slave
#1

-

CBX100/500

Reader
Slave
(up to 31)

*

l Shield
Tfloating

I?_Joooh Sesjee

RS485 HD
Termination Resistor.

Ok

PG-6000

-

CBX100/500

Earth
oo | 1

Vdc

RTX- A\

RTX+
SGND

\\

A\
yiBua xe w 00z}
a|qeD dospniny

Shield

Earth
] L

Vdc

RS485 HD
Termination Resistor.

N

PG-6000

RTX- —A

RTX+
lShield SGND
Tfloatingl Shield

Earth
GND _-l_—

vde |

Figure 43 - Matrix 210™ Multidrop Connection to a Multiplexer

* When using CBX500, the Main interface multidrop network signals: Shield, SGND, RTX+and RTX- are

repeated on terminal connector row 4 to facilitate system cabling.
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4.3 ID-NET™ INTERFACE

CBX100/500 Function
Shield Network Cable Shield
ID+ ID-NET™ network +
ID- ID-NET™ network -
REF Network Reference

4.3.1 ID-NET™ Cables

The following instructions are referred to Figure 45, Figure 46 and Figure 47.

« The general cable type specifications are: CATS twisted pair + additional CAT5 twisted
pair, shielded cable AWG 24 (or AWG 22) stranded flexible.

We recommend using DeviceNet cables (drop or trunk type) to the following reference
standards:

AN50325 — IEC 62026
UL STYLE 2502 80°C 30V

« Cable Shield MUST be connected to earth ground ONLY at the Master.

« NEVER use ID-NET™ cable shield as common reference.

« The ID-NET™ max cable length depends on the baudrate used, (see the Baudrate Table
below).
« For Common Power Connections use only 2 wires (ID+ and ID-).

DC Voltage Power cable (Vdc — GND) should be handled as a signal cable (i.e. do
not put it together with AC cable):

Wire dimensioning must be checked in order to avoid voltage drops greater than 0.8
Volts.

Cable should lie down as near as possible to the ID-NET™ cable (avoiding wide
loops between them).

« Reader's chassis may be connected to earth.

« Network inside the same building.

Baudrate Table
Baud Rate 125 kbps 250 kbps 500 kbps 1Mbps
Cable Length 1200 m 900 m 700 m *

* Application dependent, contact your Datalogic Automation representative for details.

The default ID-NET™ baudrate is 500 kbps. Lower ID-NET™ baudrates
allow longer cable lengths. The baudrate is software configurable by

NOTE authorized Datalogic Automation personnel only.
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4.3.2 ID-NET™ Response Time

The following figure shows the response time of the ID-NET™ network. This time is defined
as the period between the Trigger activation and the beginning of data transmission to the

Host.

240
220
200
180
160
140
120

100

80

Response Time (ms)

60
40

20

CONDITIONS:

Max ID-NET™ Response Time

S
—_____-—'/
_ _‘t——"'—— ,/
b l/
“““ L
""" L
[
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
Number of Nodes
== 500 kbps = = = 250 kbps = =sesuees 125 kbps

Figure 44 — ID-NET™ Response Time

e |D-NET™ M/S Synchronized layout
e message length = 50 bytes per node
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CcBX1 00/5% Main Interface HOST
Reader b E|/ RS232/RS485
Master E o s
. . ° Shield
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I EIEN ID-
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)
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Figure 45 — ID-NET™ Network Connections with isolated power blocks
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CBX100/500 Main Interface HOST
Reader N E|/ RS232/RS485
Master 5 o | s
° ° . Shield
: H\\; o | [Shield vy
IR EN > \f\}
ID-NET™ | b+
Termination Resistor. O REF
Earth
GND _-I_-
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2
)
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Reader e e [ D+ |(White) 2 _
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Figure 46 - ID-NET™ Network Connections with Common Power Branch Network
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Figure 47 — ID-NET™ Network Connections with Common Power Star Network
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4.3.3 ID-NET™ Network Termination

The network must be properly terminated in the first and last reader of the network. This is
done by setting the ID-NET™ Termination Resistance Switch in the CBX100/500 to ON.

4.4 AUXILIARY RS232 INTERFACE

The RS232 auxiliary interface is available for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The parameters relative to the aux interface (baud rate, data bits, etc.) as well as particular
communication modes such as LOCAL ECHO can be defined through the Communication
folder of the VisiSet™ utility program.

The 9-pin female Auxiliary Interface connector inside the CBX is the preferred connector for
device configuration or communication monitoring.

5 1

00000
0000

9 6

Figure 48 - 9-pin female connector

If permanent system wiring is required, the following pins are used to connect the RS232
auxiliary interface:

CBX100/500 Function
RX Auxiliary Interface Receive Data
TX Auxiliary Interface Transmit Data
SGND Auxiliary Interface Reference
USER INTERFACE
RX TX
o | o | s || o | | s | s | e | | | o |
00000 000 e —‘
+V vV  O1+ O1- 02+ 02-| +v 12A 12B -V X RX
OUTPUTS INPUT2 AUX 3‘

0

O

Vdc  GND REF D+ ID- |9, vV A 1BV |s
POWER % ID-NET % TRIGGER 2

ol
Oll
> Ofl
o[l
@l
o[l
ol
ol
o[l
o[l

Reference

Figure 49 - RS232 Auxiliary Interface Connections

@ Do not connect the Aux Interface to the CBX spring clamp connectors and
the 9-pin connector simultaneously.

NOTE
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4.5 INPUTS

There are two optocoupled polarity insensitive inputs available on the reader: Input 1
(External Trigger) and Input 2, a generic input:

The External Trigger can be used in One Shot Mode or in Phase Mode. Its main functions
are:

e acquisition trigger in One Shot Mode
e reading phase-ON/reading phase-OFF command in Phase Mode

The main functions of the general purpose Input 2 are:
e second external trigger in Phase Mode
e match code storage command when the Match Code option is enabled

The electrical features of both inputs are:
Vag = 30 Vdc max.
Iin = 12 mA (reader) + 12 mA (CBX) max.

The active state of these inputs are selected in software. Refer to the VisiSet™ Help On
Line.

An anti-disturbance filter is implemented in software on both inputs so that the minimum
pulse duration is = 0.5 milliseconds. This value can be increased through the software
parameter Debounce Filter, see the Digital I/O folder in the VisiSet™ Help On Line for further
details.

These inputs are optocoupled and can be driven by both NPN and PNP type commands.

@ Polarity insensitive inputs assure full functionality even if pins A and B are
exchanged.

NOTE

The connections are indicated in the following diagrams:

CBX100/500 Function
+V Power Source - External Trigger
1A External Trigger A (polarity insensitive)
1B External Trigger B (polarity insensitive)
-V Power Reference - External Trigger

The yellow Trigger LED (Figure 15, 5) is on when the active state of the External Trigger
corresponds to ON.

52



CBX ELECTRICAL CONNECTIONS

EXTERNAL TRIGGER INPUT CONNECTIONS USING MATRIX 210™ POWER

D

CAUTION

Power is available directly to the Input Device, independently from the
Power Supply Switch inside the CBX.

PH-1 Photocell (PNP)

(brown)

(black) (blue)

| | s | s | | e
OO0
PR

—

Q

REF D+ ID- |, v NMA 1B -V
ID-NET %

 —

O

SGND
TRIGGER Aux |2

Figure 50 — PH-1 External Trigger Using Matrix 210™ Power

NPN Photocell

Power to Input
Photocell Signal
Photocell
Reference
s | | | s | e | | s — —
Vdc GND <% REF D+ ID- k%/ +V MA 1B -V ISGND
POWER "% ID-NET % TRIGGER aux |2

Figure 51 - NPN External Trigger Using Matrix 210™ Power

EXTERNAL TRIGGER INPUT CONNECTIONS USING EXTERNAL POWER

PNP Photocell

Input
Signal

Pulled down to External
Input Device Reference

—

— o | e | | e e [ [ s | [
vic GND| <&, |REF 1D+ D- |8 | +v 1A 1B v |sonp
POWER "% ID-NET % TRIGGER AuX |2

Figure 52 - PNP External Trigger Using External Power

NPN Photocell

Pulled up to External
Input Device Power

Input
Signal

o || — | | o | o || o | | |

Ol0I0I000I0D

Vdc  GND
POWER &

o || w— |

OO

REF D+ 1>-|$ | +v 1A 1B v
ID-NET %

SGND 2
3 TRIGGER AUX

Figure 53 - NPN External Trigger Using External Power
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CBX100/500 Function

+V

Power Source - Inputs

12A Input 2 A (polarity insensitive)
2B Input 2 B (polarity insensitive)
-V

Power Reference - Inputs

INPUT 2 CONNECTIONS USING MATRIX 210™ POWER

T

CAUTION

Power is available directly to the Input Device, independently from the
Power Supply Switch inside the CBX.

Input Device

Power to
Input Device

Input Input Device
Signal Reference

| | s | | s | | | e — o || — |
seeee I X Joe
+V -V 01+ 01- 02+ 02-] +V 12A 12B
OUTPUTS

o[l

V[ T™x Rx
INPUT2 aux |3

PNP Input 2 Using Matrix 210™ Power

Input Device

Power to Input
Input Device Signal

Input Device
Reference

|| o || | || |
O0|0|0O
4V -V 01+ O1- 02+ 02-| +v I2A 12B

OUTPUTS

o[l

| | —
v [™x rx
INPUT2 aux |3

NPN Input 2 Using Matrix 210™ Power

INPUT 2 CONNECTIONS USING EXTERNAL POWER

Input Device
Input
Signal

Pulled down to External
Input Device Reference

 — || o | |  — s | o || |

0l0I0I0000® @000

+V Vv 01+ O1- 02+ O02-] +Vv 12A 2B -V
OUTPUTS

X  RX
INPUT2 aux |3

Figure 54 - PNP Input 2 Using External Power
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Input Device
Pulled up to External
Input Device Power

Input
Signal

o || | | s | o e s | o || |

90000 0/® OO0

+V v 01+ 01- 02+ 02-] +v [2A 2B -V TX RX
OUTPUTS INPUT2 AUX 3

Figure 55 - NPN Input 2 Using External Power

4.6 OUTPUTS

Two optocoupled general purpose outputs are available. The meaning of the two outputs
Output 1 and Output 2 can be defined by the user. They are typically used either to signal the
data collection result or to control an external lighting system.

CBX100/500 Function
+V Power Source - Outputs
o1+ Output 1 +
0O1- Output 1 -
02+ Output 2 +
02- Output 2 -
-V Power Reference Outputs

The electrical features of the two outputs are the following:

Vce = 30 Vdc max.

Ice = 40 mA continuous max.; 130 mA pulsed max.

By default, Output 1 is associated with the Partial Read and No Read events, which activates
when the code(s) signaled by the external trigger are not decoded, and Output 2 is
associated with the Complete Read event, which activates when all the selected codes are
correctly decoded.

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/O folder in the VisiSet™ Help On Line for further details.
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OUTPUT CONNECTIONS USING MATRIX 210™ POWER

D

CAUTION

Power is available directly to the Output Device, independently from the
Power Supply Switch inside the CBX.

56

Output Device
Power to Output
Output device Signal

Output device
Reference

— o || o || e || e | | s | | | | |

[ J @00 0[0)¢e e

W v o1+ 01 Ozr 02|+ 1A 12B v | X RX
OUTPUTS INPUT2 aux |3

Figure 56 - Open Emitter Output Using Matrix 210™ Power

Output Device

Power to
Output device

Output device
Reference
Output
Signal

e | o || o || o | | s | s | | |

@ O O00OO0O

W v o1+ o1 02+ 02|+ 1A 12B v | X RX
OUTPUTS INPUT2 aux |3

Figure 57 - Open Collector Output Using Matrix 210™ Power

OUTPUT CONNECTIONS USING EXTERNAL POWER

Output Device
Pulled up to External
Output Device Power

Output
Signal

| | —| o || s | | s | o | s o o

OO O|OI0000O0O

+V vV 01+ 0O1- 02+ O02-] +V 12A 2B -V | TX RX
OUTPUTS INPUT2 AUX 3

Figure 58 - Output Open Emitter Using External Power

Output Device

Output
Signal

Pulled down to External
Output Device Reference

| | — | | | s | s | o | o | e | s | s

OO O|0I000O0OO

W v Ool+ o1 O2r 02|+ 1A 1B v | X RX
OUTPUTS INPUT2 aux |3

Figure 59 - Output Open Collector Using External Power
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4.7 EXTERNAL LIGHTING SYSTEMS

If an External llluminator is used, it can be powered from the CBX connection box. It must be
connected to the Vdc and GND terminal clamps.

& Power is available directly to the llluminator, independently from the Power
Supply Switch inside the CBX.

CAUTION

In the case of the LT-700 illuminator, one of the available digital outputs must be connected
as the control signal. In VisiSet™, configure the Output Line Function parameter to "External
Lighting System" and the Matrix Output x External Lighting System Mode parameter to
"Triggered".

Control Signal for LT-700
illuminators

[ |

08800000

i
Vo Dy 0 e+ D | -V 24 KE VX 2K

CUTFUTS INFLUTZ AUX a

@l

Oll

[ [ e e [ e [ e e
00000000

veo CNS |4 | RFF - 1 e |-V HA 1A [ T
FOWECR E IC-NCT <% TUWRCR a4

Power to External
llluminator

Figure 60 — External Lighting System Connections

Below is a table summarizing the External llluminator wiring and power requirements:

Illuminator Wire Color CBX/Matrix Signal Meaning

LT-700 Red Vdc 10 to 30 Vdc
Black GND Ground
White Earth Shield/Earth Ground
Green 0O1- or O2- Control Signal -
Yellow 01+ or 02+ Control Signal +
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4.8 USER INTERFACE - HOST

The following table contains the pinout for standard RS232 PC Host interface. For other user

interface types please refer to their own manual.

RS232 PC-side connections

5 1

13

9-pin male connector

\.............'........... }

14 25

25-pin male connector

Pin Name Pin Name
2 RX 3 RX
3 X 2 TX
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS
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5 25-PIN CABLE ELECTRICAL CONNECTIONS

5.1 25-PIN CONNECTOR

The Matrix 210™ reader is equipped with a 25-pin male D-sub connector for connection to
the power supply, serial interfaces and input/output signals. The details of the connector pins

are indicated in the following table:

\

13

........................./

14 25

Figure 61 - 25-pin Male D-sub Connector

25-pin D-sub male connector pinout

Pin Name Function
13,9 Vdc Power supply input voltage +
25,7 GND Power supply input voltage -
1 CHASSIS Cable shield connected to chassis
18 1A External Trigger A (polarity insensitive)
19 1B External Trigger B (polarity insensitive)
6 12A Input 2 A (polarity insensitive)
10 12B Input 2 B (polarity insensitive)
8 o1+ Output 1 +
22 O1- Output 1 -
11 02+ Output 2 +
12 02- Output 2 -
20 RX Auxiliary RS232 RX
21 X Auxiliary RS232 TX
23 ID+ ID-NET™ network +
24 ID- ID-NET™ network -
14, 15, 16, 17 |[NC Not Connected
. RS485 RS485
Pin Name RS232 Full-Duplex Half-Duplex
2 X TX+ RTX+
3 MAIN INTERFACE RX *RX+
4 (SW SELECTABLE) RTS TX- RTX-
5 CTS *RX-

* Do not leave floating, see par. 5.4.2 for connection details.

In order to meet EMC requirements:

e connect the reader chassis to the plant earth ground by means of a flat copper braid
shorter than 100 mm;

e for direct connections, connect the main interface cable shield to pin 1 of the 25-pin

connector.
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5.2 M12-D 4-PIN CONNECTOR (ETHERNET)

In Matrix 210 21x-x1x models, an M12 D-Coded connector is provided for the on-board
Ethernet connection. This interface is IEEE 802.3 10 BaseT and IEEE 802.3u 100 BaseTx
compliant. See par. 5.7 for connection details.

Figure 62 - M12 D-Coded Female Ethernet Network Connector

M12 D-Coded Ethernet Network Connector pinout

Pin Name Function
1 TX + Transmitted data (+)
2 RX + Received data (+)
3 TX - Transmitted data (-)
4 RX - Received data (-)

5.3 POWER SUPPLY

Power is supplied to the reader through the pins provided on the 25-pin connector (see
Figure 63):

Matrix 210™ POWER SUPPLY

13 fvdc

V+ (10 - 30 Vdc)

25 iGND

VGND

1 icHAssIs CHASSIS

Earth Ground

Figure 63 - Power Supply Connection
The allowed supply voltage range is 10 to 30 Vdc.

It is recommended to connect pin 1 (CHASSIS) to a common earth ground.

5.4 MAIN SERIAL INTERFACE

The signals relative to the following serial interface types are available on the 25-pin
connector:

The main serial interface type and its parameters (baud rate, data bits, etc.) can be
defined by the user via VisiSet™ software. The RS485 half duplex is automatically set
whenever MUX32 communication protocol is enabled. For more details refer to the
"Communication” folder in the VisiSet™ Help On Line.

Details regarding the connections and use of the interfaces are given in the next paragraphs.
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5.4.1 RS232 Interface

The RS232 interface can be used for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The following pins of the 25-pin connector are used for RS232 interface connection:

Pin |Name Function
2 TX Transmit Data
3 RX Receive Data
4 RTS Request To Send
5 CTS Clear To Send
7 GND Ground

It is always advisable to use shielded cables. The overall maximum cable length must be
less than 15 m (49.2 ft).

Matrix 210™ USER INTERFACE
: CRANE RXD
3 RX XD
4| |RTS cTS
5 CTS RTS
7 i | GND
GND
Chassis i 1:

Figure 64 - RS232 Main Interface Connections Using Hardware Handshaking

The RTS and CTS signals control data transmission and synchronize the connected devices.

START OF END OF
+V TRANSMISSION TRANSMISSION
RTS
v —/f— —/—
DATA DATA
TRANSMISSION TRANSMISSION

+V
-V —— —7/—

TRANSMISSION STOPPED
ENABLED ENABLED

+V ¢ 4
A\
-V

IDLE DISABLED IDLE
Figure 65 - RS232 Control Signals

If the RTS/CTS handshaking protocol is enabled, Matrix 210™ activates the RTS output to
indicate a message is to be transmitted. The receiving unit activates the CTS input to enable
the transmission.

61



MATRIX 210™ REFERENCE MANUAL

5.4.2 RSA485 Full-Duplex Interface

The RS485 full-duplex (5 wires + shield) interface is used for non-polled communication
protocols in point-to-point connections over longer distances (max 1200 m / 3940 ft) than
those acceptable for RS232 communications or in electrically noisy environments.

The following pins of the 25-pin connector are used for RS485 full-duplex communication:

Pin |Name Function
2 TX+ RS485 Transmit Data (+)
3 RX+ RS485 Receive Data (+)
4 TX- RS485 Transmit Data (-)
5 RX- RS485 Receive Data (-)
7 GND Ground
Matrix 210™ USER INTERFACE
Y
3]
5%
7]
Chassis 1

Figure 66 - RS485 Full-duplex Connections

@ For applications that do not use RX485 signals, do not leave these lines
floating but connect them to GND as shown below.

NOTE
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Matrix 210™

Chassis

USER INTERFACE

2 5[y Tx+

H +
4| \rx- RX485
3 : RX+
58 [rx-
7 GND

i GND

1

Figure 67 - RS485 Full-duplex Connections using Only TX Signals
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5.4.3 RS485 Half-Duplex Interface

@ This interface is provided for backward compatibility. We recommend using
the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.
NOTE

The RS485 half-duplex (3 wires + shield) interface is available for polled communication
protocols.

It can be used for Multidrop connections with a Datalogic Multiplexer, (see par. 6.5) exploiting
a proprietary protocol based on polled mode called MUX32 protocol, where a master device
polls slave devices to collect data.

The following pins of the 25-pin connector are used for RS485 half-duplex communication:

Pin |Name Function
2 RTX+ RS485 Receive/Transmit Data (+)
4 RTX- RS485 Receive/Transmit Data (-)
7 GND Ground

Matrix 210™ MULTIPLEXER
2_ ﬂ RTX

RTX485 +

4 f RTX-

RTX485 -

GND
RS485REF

Chassis

Figure 68 - RS485 Half-duplex Connections
This interface is forced by software when the protocol selected is MUX32 protocol.

In a Multiplexer layout, the Multidrop address must also be set via serial channel by the
VisiSet™ utility or by the Host Programming Mode.
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The figure below shows a multidrop configuration with Matrix 210™ readers connected to a
Multiplexer.

& This is an example of multidrop wiring. Consult the multiplexer manual for
complete wiring instructions.
CAUTION

L Max 2 m

X
— _@ 120 Ohm Wv-l y
(D

i

#x

(up to 31) C)

@ PG-6000 - -

\

Reader
#1

(25)
1 &
1 &
O

@ PG-6000

Reader
#0

w 00Z1 XelN dlqed doipyny

(25)
-
1\ &,
-
de PG-6000 <\_/>

MULTIDROP+
12000 = | iy TIpROP- )

Multiplexer | MULTIDROP GND}

PG-6000
1l
V-

Multidrop Cable SHIELD

pleIUS

Main Interface

RS232/RS485
HOST

Figure 69 - Matrix 210™ Multidrop Connection to a Mutiplexer
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5.5

5.5

ID-NET™ INTERFACE
Pin |Name Function
23 ID+ ID-NET™ network +
24 ID- ID-NET™ network -
7 GND Ground

.1 ID-NET™ Cables

The following instructions are referred to Figure 71, Figure 72 and Figure 73.

The general cable type specifications are: CAT5 twisted pair + additional CAT5 twisted
pair, shielded cable AWG 24 (or AWG 22) stranded flexible.

We recommend using DeviceNet cables (drop or trunk type) to the following reference
standards:

AN50325 — IEC 62026
UL STYLE 2502 80°C 30V

Cable Shield MUST be connected to earth ground ONLY at the Master.
NEVER use ID-NET™ cable shield as common reference.

The ID-NET™ max cable length depends on the baudrate used, (see the Baudrate Table
below).
For Common Power Connections use only 2 wires (23 and 24).

DC Voltage Power cable (Vdc — GND) should be handled as a signal cable (i.e. do
not put it together with AC cable):

Wire dimensioning must be checked in order to avoid voltage drops greater than 0.8
Volts.

Cable should lie down as near as possible to the ID-NET™ cable (avoiding wide
loops between them).

Reader's chassis may be connected to earth.

Network inside the same building.

Baudrate Table

Baud Rate 125 kbps 250 kbps 500 kbps 1Mbps

Cable Length 1200 m 900 m 700 m *

* Application dependent, contact your Datalogic Automation representative for details.

The default ID-NET™ baudrate is 500 kbps. Lower ID-NET™ baudrates
allow longer cable lengths. The baudrate is software configurable by

NOTE authorized Datalogic Automation personnel only.
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5.5.2 ID-NET™ Response Time

The following figure shows the response time of the ID-NET™ network. This time is defined
as the period between the Trigger activation and the beginning of data transmission to the
Host.

Max ID-NET™ Response Time

240

220

200

180

160

140

120

“’
R

100 —

Response Time (ms)

o
80 & P
"‘
.

60 as

40

20

o 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Number of Nodes
= 500 kbps = =+ 250 kbps = =seeeee- 125 kbps

Figure 70 — ID-NET™ Response Time

CONDITIONS:

e ID-NET™ M/S Synchronized layout
e message length = 50 bytes per node
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RS232/RS485
HOST

Max 0.3 m

Reader 23

00 |

Slave 24

(up to 31) C)

@ PG-6000

120 Ohm Wﬁl —a
®

// ~

\
\
\

1 -~ ~1

Reader 23
Slave 24
#1

@ PG-6000

Main Interface

Too :

yjbus| xew Jo} ajqe] ajeipneg o) 194y ,

| P

Reader
Master 4

390

Odw\_g_

Cable Shield 120 Ohm

é PG-6000
(25)

Figure 71 — ID-NET™ Network Connections with isolated power blocks
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68

Figure 72 - ID-NET™ Network Connections with Common Power Branch Network

Max 0.3 m
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RS232/RS485
HOST

Main Interface

Figure 73 — ID-NET™ Network Connections with Common Power Star Network

Max 0.3 m
Ij@ 120 Ohm ﬁ —_—
Reader
Slave _@ ﬂ
(up to 31)
Reader @ 7
Slave @ ?
#1
—Q32
S 4
Reader —@ ®
é’ Master —@ ]
<
§ 120 Ohm
Vdc GND @ Cable Shield
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yibua| Xew 10} a|qe] ajeipneg 0} 19JoY ,

3|qed 13N-dl
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5.5.3 ID-NET™ Network Termination

The network must be properly terminated by a 120 Ohm resistor at the first and last reader of
the network.

5.6 AUXILIARY RS232 INTERFACE

The RS232 auxiliary interface is available for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The parameters relative to the aux interface (baud rate, data bits, etc.) as well as particular
communication modes such as LOCAL ECHO can be defined through the Communication
folder of the VisiSet™ utility program.

The following pins of the 25-pin connector are used for auxiliary interface communication:

Pin |Name Function
20 RX Received data
21 TX Transmitted data
7 GND Ground
Matrix 210™ USER INTERFACE
20
ﬂ RX TXD
21§ [TX
RXD
t 17 i IGND
: GND
Chassis 1

Ruce codes comomes S

Figure 74 - RS232 Auxiliary Interface Connections Using
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5.7 ETHERNET INTERFACE (MATRIX 210 21X-X1X MODELS ONLY)

The Ethernet Interface can be used for TCP/IP communication with a remote or local host
computer by connecting the reader to either a LAN or directly to a host PC. There is no need
to use a crossover adapter since Matrix 210™ incorporates an auto-cross function.

The following is an example of a connection to a LAN using a CAB-ETH-MOx cable:

M12 D-Coded Connector Pinout
Pin Name Function
1 TX+ Transmitted data (positive pin)
2 RX+ Received data (positive pin)
3 TX- Transmitted data (negative pin)
4 RX- Received data (negative pin)

MATRIX LAN

TX+

M12 RX+ RJ45
D-coded

Figure 75 - Straight-Through Cable

On the Matrix 210™ Ethernet interface the following communication channels are available:
e Data Socket
e Image Socket
o WebSentinel Socket
¢ Image FTP Client
e HTTP Server
e Ethernet IP
e Modbus TCP

For further details refer to the Ethernet Folder in the VisiSet™ Help On Line and to the
"Matrix Ethernet Service Guide.pdf" document provided as supplementary documentation.

7



o MATRIX 210™ REFERENCE MANUAL

5.8 INPUTS

There are two optocoupled polarity insensitive inputs available on the 25-pin connector of the
reader: Input 1 (External Trigger) and Input 2, a generic input:

The External Trigger can be used in One Shot Mode or in Phase Mode. Its main functions
are:

e acquisition trigger in One Shot Mode
e reading phase-ON/reading phase-OFF command in Phase Mode

The main functions of the general purpose Input 2 are:
e second external trigger in Phase Mode
e match code storage command when the Match Code option is enabled

The electrical features of both inputs are:
Maximum voltage: 30 Vdc
Maximum current: 12 mA

The active state of these inputs are selected in software. Refer to the VisiSet™ Help On
Line.

An anti-disturbance filter is implemented in software on both inputs so that the minimum
pulse duration is = 0.5 milliseconds. This value can be increased through the software
parameter Debounce Filter, see the Digital I/O folder in the VisiSet™ Help On Line for further
details.

These inputs are optocoupled and can be driven by both NPN and PNP type commands.

@ Polarity insensitive inputs assure full functionality even if pins A and B are
exchanged.

NOTE

The connections are indicated in the following diagrams:

Pin |Name Function
9 Vdc Power Supply input voltage +
18 |[1MA External Trigger A (polarity insensitive)
19 |I1B External Trigger B (polarity insensitive)
7 GND Power Supply input voltage -

The yellow Trigger LED (Figure 15, 5) is on when the active state of the External Trigger
corresponds to ON.
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EXTERNAL TRIGGER INPUT PNP PH-1

Matrix 210™ PNP PH-1 wires
i i Vde (brown) +10-30 Vdc
1A (black) NO
1B
GND (blue) 0V

Figure 76 - PH-1 Photocell (PNP) External Trigger Using Matrix 210™ Power

EXTERNAL TRIGGER INPUT CONNECTIONS USING MATRIX 210™ POWER

Matrix 210™ EXTERNAL TRIGGER

\Y
‘EI— Signal

Ground

Figure 77 — PNP External Trigger Using Matrix 210™ Power

Matrix 210™ EXTERNAL TRIGGER

Figure 78 - NPN External Trigger Using Matrix 210™ Power

EXTERNAL TRIGGER INPUT CONNECTIONS USING EXTERNAL POWER

Matrix 210™ [Vext 30 Vdc max.| pyrerNAL TRIGGER

\

MA Signal

Figure 79 - PNP External Trigger Using External Power
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Matrix 210™ |Vext 30 Vdc max.| EXTERNAL TRIGGER

i [18: A %

Figure 80 - NPN External Trigger Using External Power

Pin |Name Function
9 Vdc Power Supply input voltage +
6 I2A Input 2 A (polarity insensitive)
10 |12B Input 2 B (polarity insensitive)
7 GND Power Supply input voltage -

INPUT 2 CONNECTIONS USING MATRIX 210™ POWER

Matrix 210™ INPUT DEVICE

‘El— Signal

\

Ground

Figure 81 - PNP Input 2 Using Matrix 210™ Power

Matrix 210™ INPUT DEVICE

Figure 82 - NPN Input 2 Using Matrix 210™ Power
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INPUT 2 CONNECTIONS USING EXTERNAL POWER

[Vext 30 Vdc max.| \\pyrpEVICE

Matrix 210™
\

.......

Figure 83 - PNP Input 2 Using External Power

Matrix 210™ |Vext 30 Vdc max.| INPUT DEVICE

Figure 84 - NPN Input 2 Using External Power

5.9 OUTPUTS

Two opto-coupled general purpose outputs are available on the 25-pin connector. The
meaning of the two outputs Output 1 and Output 2 can be defined by the user. They are
typically used either to signal the data collection result.

The pinout is the following:

Pin |Name Function

9 Vdc Power Supply input voltage +

8 o1+ Configurable digital output 1 - positive pin
22 |O1- Configurable digital output 1 - negative pin
11 o2+ Configurable digital output 2 - positive pin
12 | 02- Configurable digital output 2 - negative pin
7 GND Power Supply input voltage -

The electrical features of the two outputs are the following:

Vce max = 30 Vdc
I max = 40 mA continuous; 130 mA pulsed

By default, Output 1 is associated with the Partial Read and No Read events, which activates
when the code(s) signaled by the external trigger are not decoded, and Output 2 is
associated with the Complete Read event, which activates when all the selected codes are
correctly decoded.
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The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/O folder in the VisiSet™ Help On Line for further details.

Matrix 210™ USERINTERFACE |Vext 30 Vdc max|

8/11 O+

RN -

= --ru-‘r
L

Figure 85 - Open Emitter Output Connection

Matrix 210™ USERINTERFACE [Vext 30 Vdc max.

o

C 8/11 O+ L
1“" ’{ Eznz 0O-
E

Figure 86 - Open Collector Output Connection
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5.10 USER INTERFACE

The following table contains the pinout for standard RS232 PC Host interface. For other user
interface types please refer to their own manual.

RS232 PC-side connections
] 5 1 13
e00000000000e0
\ooooo.cooooo/
5 3 14 25
9-pin male connector 25-pin male connector
Pin Name Pin Name
2 RX 3 RX
3 TX 2 X
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS

How To Build A Simple Interface Test Cable:

The following wiring diagram shows a simple test cable including power, external (push-
button) trigger and PC RS232 COM port connections.

25-pin D-sub male 9-pin D-sub female

21 ™ /N N\ 2 LRX
20 RX { \ \3 ™ »E
7_GND \ } /5 GND
N4 /
13 Vdc

Matrix 210™ « 25 GND

- 13 Vdc —
- 18|1A

19 I1B

Power Supply
Vdc (10 — 30 Vdc)
Power GND

Trigger |—|

Test Cable for Matrix 210™

Figure 87- Test Cable for Matrix 210™
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6 TYPICAL LAYOUTS

The following typical layouts refer to system hardware configurations. However, they also
require the correct setup of the software configuration parameters. Dotted lines in the figures
refer to optional hardware configurations within the particular layout.

6.1 POINT-TO-POINT

(21x-x0x and 21x-x1x models)

In this layout the data is transmitted to the Host on the main serial interface. The RS232
auxiliary interface can be used for reader configuration by connecting a laptop computer
running VisiSet™. Host Mode programming can be accomplished either through the main
interface or the Auxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the main interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an

External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

PG6000

oo

L

I_ 1T°°1T ﬂ— —_— @® Main Serial Interface (R$232 or RS485 Full-Duplex)
[ | @ @ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Matrix 210™

[
| Terminal
|

Figure 88 — Serial Interface Point-to-Point Layout
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In this layout the data is transmitted to the Host on the TCP/IP Ethernet interface (CBX500
with BM200/210 Host Interface Module installed). The RS232 auxiliary interface can be used
for reader configuration by connecting a laptop computer running VisiSet™. Host Mode
programming can be accomplished either through the TCP/IP Ethernet interface or the
Aukxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the TCP/IP Ethernet selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

Power
S JOC
—loa ¢ | cBx500
Matrix 210™ | : ®
I_ 1 S | ® BM200/210 TCP/IP Ethernet Interface
D @ Auxiliary Serial Interface (Local Echo) (RS232)
1 @ ® External Trigger (for One Shot or Phase Mode)
Host

Figure 89 — BM200/210 TCP/IP Ethernet Interface Point-to-Point Layout
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In this layout a single scanner functions as a Slave node on a Fieldbus network. The data is
transmitted to the Host through an accessory Fieldbus interface board installed inside the
CBX500 connection box.

Reader configuration can be accomplished through the Auxiliary interface using the VisiSet™
configuration program or Host Mode programming.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the Fieldbus interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

Power

Matrix 210™ é

CBX500

@ Fieldbus Interface (Profibus, DeviceNet, etc.)
@ Auxiliary Serial Interface (Local Echo) (RS232)
Host ® External Trigger (for One Shot or Phase Mode)

Figure 90 — Fieldbus Interface Point-to-Point Layout
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6.2 PASS-THROUGH

(21x-x0x and 21x-x1x models)

6.2.1 Pass-Through on RS232

Pass-through mode allows two or more devices to be connected to a single external serial
interface.

Each reader transmits the messages received by the Auxiliary interface onto the Main
interface. All messages will be passed through this chain to the host.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

Applications can be implemented to connect a device such as a hand-held reader to the
Auxiliary port of the last reader in the chain for manual code reading capability.

The Main and Auxiliary ports are connected as shown in the figure below:

® @ ®e ®

Device#2 % Device#

|
®| ®
d H} =

1 I | I

Device#1

L
*

@ Main Serial Interface (RS232 only)
@ Auxiliary Serial Interface (RS232)
® External Trigger (for One Shot or Phase Mode)

Figure 91 — Pass-Through Layout

@ The reading device connected to the Host can be connected to a Fieldbus
network using a Host Interface module through a CBX500 connection box.

NOTE
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6.2.2 Pass-Through on ID-NET™

An alternative Pass-Through layout allows the more efficient ID-NET™ network to be used.
This layout is really an ID-NET Master/Slave Multidata layout which also allows each reader
(Master and Slaves) to accept input on the Auxiliary interface, for example to connect a
device such as a hand-held reader for manual code reading capability.

Each Matrix 210™ transmits its own messages plus any messages received by its Auxiliary
interface onto the ID-NET™ interface. The Master passes all messages to the Host.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

® ©®

/L
/L
7/

Master Slave#2

&’ Slave#n

@® Main Serial Interface (RS232 or RS485)

@ Auxiliary Serial Interface (RS232)

® External Trigger (for One Shot or Phase Mode)
@ ID-NET™

Figure 92 — Pass-Through On ID-NET™ Layout

@ The reading device connected to the Host can be connected to a Fieldbus
network using a Host Interface module through a CBX500 connection box.
NOTE
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6.3 ID-NET™

(21x-x0x and 21x-x1x models)

The ID-NET™ connection is used to collect data from several readers to build a multi-point or
a multi-sided reading system; there can be one master and up to 31 slaves connected
together.

The slave readers are connected together using the ID-NET™ interface. Every slave reader
must have an ID-NET™ address in the range 1-31.

The master reader is also connected to the Host on the RS232/RS485 main serial interface.
For a Master/Slave Synchronized layout the External Trigger signal is unique to the system;

there is a single reading phase and a single message from the master reader to the Host
computer. It is not necessary to bring the External Trigger signal to all the readers.

In the Master/Slave Synchronized layout the Master operating mode can only be set to
Phase Mode.

The main, auxiliary, and ID-NET™ interfaces are connected as shown in the figure below.

OO,

Power

Host ® Main Serial Interface (RS232 or RS485)
e @ External Trigger
\ ® ID-NET™ (up to 16 devices - practical limit)

Figure 93 — ID-NET™ M/S Synchronized Layout

The Master reader can be connected to the CBX series connection box (CBX + BM100
module) or to a QL500 having sw version 2.02.01 and later, with the advantage of the
Backup and Restore configuration function. If the Backup and Restore function is not
required, then a QL300 can be used to connect the master reader.
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CAB-AUX03 CAB-AUX03
ID-NET™
CBL-1480-xx - CBL-1480-xx
' Slave Nodes
I CBL-1490
Master ID-NET
Terminator

The ID-NET network must be terminated through
the internal switch of the CBX500 and inserting an
ID-NET terminator into the last QL in the network.

Power
CAB-PW-EXT ® BA600 ID-NET™ Out
(3 BA400 Ext. Power
@ BAS500 Trigger
CBX500 ® BA300 Service
CAB-AUX03
Figure 94 - ID-NET™ M/S Synchronized Layout
Matrix 210™ Master with CBX500 + Matrix 210™ Slaves with QL150
Aux Aux
CBL-1496
ID-NET
Terminator ID-NET™ QL150
CBL-1480-xx CBL-1480-xx
Master
Slave Nodes CBL-1490
QL300 4——1- - o 1 1|__ ID-NET
Terminator

The ID-NET network must be terminated
inserting an ID-NET terminator into the
QL300 (Master) and into the last QL in
the network.

Power
CAB-PW-EXT
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The same configuration can be made to a Host using a TCP/IP Ethernet interface. In this
case the Master is connected to a CBX500 with BM200/210 Host Interface Module installed.

The TCP/IP Ethernet, auxiliary, and ID-NET™ interfaces are connected as shown in the
figure below.

/ /
Power 7 /
7/
H® |C Slave#1 Slave#n [[® Al
CBX500 I @

_————1
|

® m (]

Master 1

® BM200/210 TCP/IP Ethernet Interface
Host @ External Trigger

® ID-NET™ (up to 16 devices - practical limit)

Figure 96 — ID-NET™ M/S Synchronized Layout with BM200/210 TCP/IP Ethernet Interface to Host

An alternative layout to the CBXs can be made using QLs:

Aux Aux
ID-NET™ QL150
CBL-1480-xx CBL-1480-xx
Power
CAB-PW-EXT Slave Nodes CBL-1490
R ID-NET
QL500 [ - 3 Master Terminator
& S
. 1--14
| PS The ID-NET network must be terminated
e e e e e e - | I inserting an ID-NET terminator into the
last QL in the network.
Host ID-NET on the QL500 is internally
terminated.
Ethernet Interface 7 -

Figure 97 - ID-NET™ M/S Synchronized Layout with QL500 TCP/IP Ethernet Interface to Host
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For a Master/Slave Multidata layout each reader has its own reading phase independent
from the others; each single message is sent from the master reader to the Host computer.

® ®

Master

Power

Host

[ ‘ ,

==

H=— ‘
[ o

TR

'l@l'@)d
—0

©)

® Main Serial Interface (RS232 or RS485)

@ Auxiliary Serial Interface (Local Echo) (RS232)

® External Trigger (for One Shot or Phase Mode)

@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 98 — ID-NET™ M/S Multidata

NOTE

The auxiliary serial interface of the slave readers can be used in Local
Echo communication mode to control any single reader (visualize
collected data) or to configure it using the VisiSet™ ultility.

The ID-NET™ termination resistor switches must be set to ON only in the first
and last CBX connection box.
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The same configuration can be made to a Host using a TCP/IP Ethernet interface. In this
case the Master is connected to a CBX500 with BM200/210 Host Interface Module installed.

The TCP/IP Ethernet, auxiliary, and ID-NET™ interfaces are connected as shown in the
figure below.

Power @ ////

CBX500

;:
@
]
©
°
®

immmnnn®

Slave#1 | Slave#n |

F}-- .ﬂ-——l F1-- -ﬂ-——l Terminal I------ﬂ-——!

o

— ® — —
ri" . Host
“_:.,. ‘
@ == I
_— ® BM200/210 TCP/IP Ethernet Interface

— @ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)
@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 99 — ID-NET™ M/S Multidata Layout with BM200/210 TCP/IP Ethernet Interface to Host

The auxiliary serial interface of the slave readers can be used in Local Echo
communication mode to control any single reader (visualize collected data)
or to configure it using the VisiSet™ utility.

NOTE The ID-NET™ termination resistor switches must be set to ON only in the first
and last CBX connection box.
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Alternatively, the Master scanner can communicate to the Host as a Slave node on a
Fieldbus network. This requires using an accessory Fieldbus interface board installed inside
the CBX500 connection box.

System configuration can be accomplished through the Auxiliary interface of the Master
reader (internal CBX500 9-pin connector) using the VisiSet™ configuration program or Host
Mode programming.

Power
Slave#1 '.o],c_)c‘
I_ LB N ]
Master "1
|
S
® —

@ Fieldbus Interface
@ External Trigger (for One Shot or Phase Mode)
@ ID-NET™ (up to 16 devices - practical limit)

Figure 100 — ID-NET™ Fieldbus M/S Synchronized Layout

Power 7 /

Master Slave#1 ' Slave#n ‘Iol,(_)c‘

|5@

L]
I Terminal

@ Fieldbus Interface

@ Auxiliary Serial Interface (Local Echo) (RS232)

® External Trigger (for One Shot or Phase Mode)

@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 101 — ID-NET™ Fieldbus M/S Multidata
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6.4 RS232 MASTER/SLAVE

(21x-x0x and 21x-x1x models)

@ This interface is provided for backward compatibility. We recommend using
the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.
NOTE

The RS232 master/slave connection is used to collect data from several readers to build either
a multi-point or a multi-sided reading system; there can be one master and up to 9 slaves
connected together.

The Slave readers use RS232 only on the main and auxiliary serial interfaces. Each slave
reader transmits the messages received by the auxiliary interface onto the main interface. All
messages will be passed through this chain to the Master.

The Master reader is connected to the Host on the RS232/RS485 main serial interface.

There is a single reading phase and a single message from the master reader to the Host
computer.

In this layout the Master operating mode can be set only to Phase Mode.

The Phase ON/OFF signals must be brought only to the Master. It is not necessary to
bring them to the Slave readers.

The main and auxiliary ports are connected as shown in the figure below.

® @ ® @ L, @

/L
7/

% Slave#1 | S 4] Slave#n |

@

-
!
Power —@ D..--..'

Master [ ]

@ Main Serial Interface (Slaves RS232 only)
@ Auxiliary Serial Interface (RS232)
® External Trigger

Figure 102 — RS232 Master/Slave Layout
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6.5 MULTIPLEXER
(21x-x0x and 21x-x1x models)

@ This interface is provided for backward compatibility. We recommend using
the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.
NOTE

Each reader is connected to a Multiplexer (for example MX4000) with the RS485 half-duplex
main interface through a CBX connection box.

Before proceeding with the connection it is necessary to select the MUX32 communication
protocol and the multidrop address for each reader.

®

® Main Serial Interface (RS485 Half-Duplex)
@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Figure 103 - Multiplexer Layout

The auxiliary serial interface of the slave readers can be used in Local Echo communication

mode to control any single reader (visualize collected data) or to configure it using the
VisiSet™ utility.

Each reader has its own reading phase independent from the others. When One Shot or
Phase Mode operating mode is used, the reader can be activated by an External Trigger (for
example a pulse from a photoelectric sensor) when the object enters its reading zone.
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6.6 ETHERNET CONNECTION

(21x-x1x models only)

For Matrix 210 21x-x1x models, the Ethernet connection is possible in two different layouts.
In both layouts, before proceeding with the connection, it is necessary to configure the reader
Ethernet parameters via VisiSet™. For further details, see the Ethernet Folder in the
VisiSet™ Help On Line.

“In a Point-to-Point layout the reader is connected to a local host by using a CAB-ETH-MO0x
cable There is no need to use a crossover adapter since Matrix 210™ incorporates an auto-
cross function.

Matrix 210™

@ Ethernet Interface
@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

PG 6000 —®— D"""'I

Figure 104 - Ethernet Point-to-Point Layout
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When using a Local Area Network (LAN), one or more Matrix 210 21X-X1X can be
connected to the network by using CAB-ETH-MOXx cables:

I

CAB-MSxx

Matrix 210™
) B, Wy
3
=
£
w
i 0 || e
I |
!
4 |
=R -
_I
T
Power
®
— HOST
NETWORK | B
= ;
= f

® Ethernet Interface

@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Figure 105 - Ethernet Network Layout
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6.7 USB CONNECTION

(21x-x2x models only)

For Matrix 210 21x-020 models, the USB connection is possible in two different layouts. The
default baud rate is 115200. To maximize data transfer you can set it up to 921600 by
configuring the reader though the Communication parameters via VisiSet™. For further
details, see the Communication Folder in the VisiSet™ Help On Line.

In a Point-to-Point layout the reader is connected to a local host through its USB cable. No
external power supply is necessary.

Matrix 210™

L |
Figure 106 - USB Point-to-Point Layout

One or more Matrix 210™ USB models can be connected to USB Hub. The HUB must be
able to supply 500 mA to each port.

| Matrix 210™

HOST
USB HUB

Figure 107 — Multi USB Hub Layout
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7 READING FEATURES

Focus | Field of View " | PPI? Typ. 2D Code Resolution Reading
Distance mm (in) Linear and mm (mils) Distance
MODELS mm (in) Stacked mm (in)
Code. min. max.
Resolution
mm (mils)
Max. | 0.076(3) | 28 (1.10) | 32 (1.26
214-xxx UHD 30 165105 | 4150 | 0.063 (2.5) |—mx (3) (1.10) (1.26)
(1.18) (0.65x 0.41) Typ. | 0.13 (5) | 23 (0.91) | 38 (1.50)
Max. | 0.13 (5 . .
211-xxx NEAR 49 3622 545 | 0410 (4) | (5) | 42 (165) | 53 (2.08)
(1.77) (1.38 x 0.87) Typ. | 0.19 (7.5) | 36 (1.42) | 61 (2.40)
Max. | 0.19 (7.5) | 54 (2.13) | 90 (3.54
212-xxx MEDIUM (2636) 1 gg x ?226 380 | 0.15(6) (7.5) (213 (354
: (1.97 x 1.26) Typ. | 0.25 (10) | 47 (1.85) | 101 (3.97)
Max. | 0.25 (10) | 85 (3.35) | 135 (5.31
213-xxx FAR ﬂ% 80 x50 238 | 0.20 (8) (10) (3-35) (5-31)
(4.13) (3.15 x 1.97) Typ. | 0.38 (15) | 70 (2.76) | 192 (7.55)

(1)
(2)
(3)

@ Focus Distance

Pixels per inch @ Focus Distance
Measurement Conditions:

. Test Chart: provided with the reader

. Still code at the center of the FOV

. Code Symbology: Data Matrix ECC 200
e  Tilt Angle: 45°

. Skew Angle: 15°

. Image Processing Mode = Advanced Code Setting

e Module Size (mils) equal to the resolution of the code to read

. Image Processing Self Tuning = Enabled

. Image Processing Self Tuning Mode = Code Contrast Levels Only *
. Image Acquisition Self Tuning = Enabled (for 213-xxx models only)

* This parameter setting can increase the image processing time.
All distances are measured from the reading window to the code surface.

Depending on the code resolution, symbology and number of characters in the code, the
Reading Area can be different from the FOV.
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7.1 MAXIMUM LINE SPEED CALCULATION

The Exposure Time (or Shutter) parameter defines the time during which the image will be
exposed to the reader sensor to be acquired. This parameter depends heavily on the
environmental conditions (external lighting, image contrast etc.).

In general, a longer time corresponds to a lighter image but is susceptible to blurring due to
the code movement; a shorter exposure time corresponds to a darker image.

The following considerations must be applied only when the internal lighting
system and 2D codes are used. The Maximum line speed allowed for linear
codes or postal code reading applications heavily depends on the direction
of symbol movement. When the direction of movement is parallel to the
NOTE . .
elements of the code, the maximum speed is greater.
Assuming:

e X: Code Resolution (mm)
o Texp: Exposure Time (s)

e LS: Line Speed (mm/s)
The essential condition to avoid blurring effects between two adjacent elements in a dynamic
reading application is:
LS x Texp < X
The maximum (theoretical) line speed (LS) can be calculated as follows:

X/ Texp (min) = LS (max)

Texp (min) is the minimum Exposure Time value obtainable for the specific application. It
can be evaluated in static reading conditions and may depend on code printing quality,
reader position, etc.

Using the formulas previously explained it is possible to calculate the theoretical maximum
line (target) speed expected for the application, based on the maximum code resolution and
the minimum suitable Exposure Time value.

The minimum Exposure Time value depends on the Matrix reader model selected for the
application (reading distance) and on external lighting.
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The Internal Lighting Mode parameter allows to set the operating mode of the internal
lighting system. The possible values are:

Disabled: the built-in lighting system is turned off all the time. This option can be useful
only if external lighting is sufficient;

Always ON: the built-in lighting system is turned on all the time at the lowest power level.
This option is useful if the lighting system blinking (Strobed operating mode) disturbs the
operator.

Very High/High/Medium-Power Strobed: the built-in lighting system is on only during the
image exposure time. Three different lighting levels can be set.

automatically limits the range of allowed values for the Exposure Time
parameter. Therefore, after changes to Internal Lighting Mode, recheck
NOTE Exposure Time.

@ To avoid LED array overheating, for Power Strobed settings, the program

CAUTION:

The maximum target speed in the application is affected by these conditions:

[ ]
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Code/Background Contrast: maximum speed decreases when decreasing image
contrast (poor quality codes, reflective transparent coverings, different supports and
printing techniques).

Code Resolution: maximum speed increases when decreasing code resolution (there is
a decrement of overlapping effects between two adjacent elements).

Tilt Angle: maximum speed decreases when increasing Tilt angle (from 0 to 45
degrees).
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8 SOFTWARE CONFIGURATION

Software configuration of your Matrix 210™ for static reading or simple code reading
applications can be accomplished by the Rapid Configuration procedure using the X-
PRESS™ HMI (which requires no external configuration program) or by using the VisiSet™
Setup Wizard for easy setup. These procedures are described in chapter 1.

For other applications use VisiSet™ through the reader serial ports.

through the Ethernet port of the reader (Ethernet models only), or QL500 or
BM2x0 Host Interface module. See the "Configuration Through Ethernet”
page in the VisiSet™ Help On-Line, or the "Matrix Family Setup Procedure
Using Programming Barcodes" document on the Mini-DVD.

@ For Ethernet applications, connections to VisiSet™ can be made directly

NOTE

8.1 VISISET™ SYSTEM REQUIREMENTS

To install and run VisiSet™ you should have a Laptop or PC that meets or exceeds the
following:

e Pentium processor

e Windows 98/2000, NT 4.0, XP, Vista or 7

e 32 MB Ram

o 5 MB free HD space

o one free RS232 serial port with 115 Kbaud

e Video Adapter (1024 x 768) or better using more than 256 colors

8.2 INSTALLING VISISET™

To install VisiSet™, proceed as follows:

1. Turn on the Laptop or PC that will be used for configuration (connected to the Matrix
210™ communication ports).

2. After Windows finishes booting, insert the Mini-DVD provided.
Launch VisiSet™ installation by clicking Install.

Follow the instructions in the installation procedure.
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8.3 STARTUP

After completing the mechanical and electrical connections to Matrix 210™, you can begin
software configuration as follows:

1. Power on the Matrix 210™ reader. Wait for the reader startup. The system bootstrap
requires a few seconds to be completed. The reader automatically enters Run Mode.

Run the VisiSet™ program.

Press Connect on the VisiSet™ menu bar. The PC will automatically connect to the
Matrix 210™ reader.

Upon connection, Matrix 210™ exits Run Mode and displays the Main Menu on VisiSet™
with all the commands necessary to monitor your reader's performance. You can select
these commands using the mouse or by pressing the key corresponding to the letter
shown on the button. See Figure 108.

tH visiset

File Edit Conmect Disconmect Dewice ©Options  Tools Help

MATH MEHU
Device: Matrix 210

M. Setup Wizard Model: 211-110
Communication Port: Auxiliary

F. Calibration Tool

Standard Application Program for Matrix Family Rel. 6.10
V. Symbol Verification

A. Fun Mode

B. Capture Image

C. Decode Last Image

D. View Last Image

E. Download Last Image

H. Upload Bitmap Image
Q. Image Buffer Terminal
: Window

3. Button Function Menu

Commands Status Bar
Window

Connection: Def_Matrix on 172.27.101.81 Reader Status: OFF LIME MODE fLDg 1 OFF

Figure 108 - Main Window
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8.3.1 VisiSet™ Options

The Options item from the VisiSet™ menu (see Figure 108) presents a window allowing you
to configure:

— the logging function (Log)
— VisiSet™ window properties (Environment)

— VisiSet™ communication channel (Communication)

B visiset Options

Save Exit

Log lEnvwronment Cormmunication

Log options
Log File Mame

J.\Iog.m Browse

Default Open State Delete old log file
& OFF oM & OFF oM

Log Print Lewvel
& Everything

" Only Codes

" Only Errars

Exit

Figure 109 - Options - Log

(8 visiset Options

Save Exit

Lag Environment | Communication

Font & Background

Text example

e

Restore Factory Seftings

Change Background

Save Exit

Figure 110 - Options - Environment
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M visiset Options

Save  Exit

Log ] Environment  Communication

Comraunication Channel

" Serial port « LUSB " Ethermst
Autoconnect parts Starting port configuration for auto search
Fort Baud rate (bps); | Stop bits-
v [comi < © COMI 2400 i
| - 4500
Vo |COM2 & COM? o -
r iCOMS -
€ COM3 19200
COM4 =
| ~ 38400 Paity
57600
@ Mone
115200
" 230400 ™ Ewven
° 4B0800

© Odd

)

Exit

Figure 111 - Options — Communication

Eﬂ VisiSet Options

Save Exit

Log ] Environment  Communication 1

Communication Channel
" Serial port  USB &+ Ethemet

Device Ethernet Channel Address

IP Address [rrateriaz
IF Port Mumber i a7 File IF Port Mumber 51934

Stop Device Network Searching ‘

Device IO IP Address IMAC Mutmber i)
MATRL 72161112 0007BEO04389

MATRlx R T T

MATRLX 172161116 0007BEOO3ESC

MATRLX 1721611171 0007BEO02O9E &

Exit

Figure 112 - Options — Communication: Ethernet
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8.4 CONFIGURATION

Once connected to Matrix 210™ as described in par. 8.3, you can modify the configuration
parameters as follows:

1.

Press the Calibration Tool button from the Main Menu. Matrix 210™ will download its
permanent memory configuration parameters with the default values (if it is the first time)
to VisiSet™. The Calibration Tool window will be displayed together with the Parameter
Setup window working in Interactive Mode (see par. 8.4.1 and par. 8.4.3).

Edit the Matrix 210™ configuration parameters according to your application
requirements.

Use the Calibration Tool to fine tune the reading performance. See par. 8.4.3.

Close the Calibration Tool window and disable the Interactive Mode by pressing the
interactive button.

Save the new configuration to the reader permanent memory by pressing the Send
button.

Close the Parameter Setup window and press Disconnect on the VisiSet™ menu bar
(see Figure 108) or launch Run Mode from the VisiSet™ Main menu.

Disconnect exits closing communication between Matrix 210™ and VisiSet™, and
causes Matrix 210™ to enter Run Mode. The disconnected reader serial port is now
available.

Run command does not close communication between Matrix 210™ and VisiSet™,
and causes Matrix 210™ to enter Run Mode. In this case the reader output messages
are displayed on the VisiSet™ terminal and the statistics are displayed in the
Statistics window (Statistics enabled).
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8.4.1 Edit Reader Parameters

The Parameter Setup window displays the configuration parameters grouped in a series of
folders. Each parameter can be modified by selecting a different item from the prescribed list
in the box, or by typing new values directly into the parameter box.

By right clicking the mouse when positioned over the name of a specific Parameter or Group,
a pop-up menu appears allowing you to directly manage that particular parameter or group.

You can View the Selected Value for each parameter.
You can Restore the Default Value of each parameter or of all the parameters of a group.

Get Properties gives information about the parameter in the form of a pop-up hint that
describes the default value and the rangel/list of valid values.

The Short Help gives information about the parameter in the form of a pop-up hint.

EE Parameter Setup

File Device Mode
Get | Send | Send Defaults | Interactive |
20 Codes ] 10 Codes ] Fostal Codes ] Image Froceszing ] Mizcellaneous |
Feading Syater Layout ] CEx Gateway ] Drizplay | Diagrostics ]
Operating Modes ] Calibr : . EDz And Keppad 1
Ciata Collection ] Match C Parameter Group Cammurication |
CODE COLLECTION 7
Mumber Of Codesz / 1
| Code Collection Filters / Dizabled
| DATA FORMAT 7
Code FieIdI.J uztification Dizabled
Code Field|Cutting Dizabled
‘ N : _ T
‘ o Parameter ————  view Selected value r
| Statistics Field Separator Sting Restore Default Yalue Single group/parameter
Statistics Field Format T |r r?:;ral?;rrcir;t
| Symbology Identifiers Short Help '
| STATISTICS '
Status Dizabled

Figure 113 - Editing Parameters
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Parameters to verify/modify:

U Operating Mode

Sets the parameters which customize the reader operating mode
starting from three main modes:

One Shot: acquires a single image based on the selected value
for the Acquisition Trigger and Acquisition Trigger Delay.

Continuous: continuously acquires images with a rate up to the
maximum allowable frame rate per second for the given sensor
depending on the decoding time and the Region of Interest
settings.

Phase Mode: acquires images during the reading phase
depending on the selected value for the Acquisition Trigger and
Acquisition Trigger Delay. The Reading Phase-ON and Reading
Phase-OFF events mark respectively the beginning and end of
the reading phase.

Q Calibration

Calibrates the acquisition parameters to maximize the reading
performance (see par. 8.4.3).

O Communication

Configures the parameters relative to each serial port regarding
the transmission, message formatting and string receiving.

Any change to the VisiSet™ communication port parameters

(baud rate, data bits, etc.) is effective as soon as the reader is
disconnected from VisiSet™.

U Reading System Layout

Allows configuring the device according to the desired layout:
Standalone, ID-NET™ or Master/Slave RS232

d WebSentinel

Enables the Ethernet WebSentinel Agent for communication with
the Datalogic WebSentinel™ plant array monitor.

O Ethernet

For (21x-x1x models) Sets the parameters related to the on-
board Ethernet interface and to its communication channels.

U CBX Gateway

Sets the parameters related to the External Host Interface
Module through the CBX500 and to its communication channels.

U Image Processing

Sets the image processing parameters shared by all available
symbologies.

4 1D & 2D, Postal Codes

Sets the characteristics of the code symbologies to be read.

U Data Collection

Defines the code-collection parameters and the output message
format.

U4 Digital I/0

Configures the reader input/output parameters.

U Match Code

Allows setting a user-defined code and relative parameters to
which the read code will be compared (matched).

1 Miscellaneous

Sets the reader name and the saved image format.

U Symbol Verification

Sets the parameters relative to the various specifications in the
Standards which regulate code validation.

U LEDs And Keypad

Sets the X-PRESS™ LED and Keypad parameters related to their
selected Functions: Beeper, Green Spot, Positioning, etc.

U Display

Sets the Display language and Layout of the BM150 Display
when using the CBX500 connection box.

O Diagnostics

Enables various diagnostic messages, formatting and actions.

When all the configuration parameters are set correctly, save them to the Matrix 210™
reader by pressing the Send button. See Figure 113.
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For successive configuration of other readers or for backup/archive copies, it is possible to
save the configuration onto your PC by selecting the Save Configuration File option from
the File menu.

From the File menu, you can also Save Configuration As Text File for a human readable
version.

Load Configuration File (available in the File menu) allows you to configure a reader from a
previously saved configuration file (.ini).

8.4.2 Send Configuration Options

The device parameters are divided into two main classes, Configuration and Environmental
which are effected differently by the Send Configuration and Send Default Configuration
commands.

Configuration Parameters regard parameters that are specific to the device. These
parameters are influenced by the Send Configuration and Send Default Configuration
commands, that is they are overwritten by these commands. The same parameters are
modified by the following "Send Configuration with Options" and "Send Default Configuration
with Options" dialogs from the Device Menu:

(H Parameter Setup

File: BeEERES Mode
izet Configuration )
[ int | Interactive |
| Send Configuration | S —
200 send Canfiguration YWwith Options b iing | Mizcellaneaus |
] ; ; ] Communication ]
R Send Default Configuration k | O i 1
J
Send Default Configuration With Options r iE e
Op : LEDs And Keypad |
OFE|  Select Mext Parameter Chrl+FL
o Select Previous Parameter Chrl+F2
| Reading Phaze OM Ext. Trig. Leading Edoge
| Acquizition Trgger Continuous
Acguiziion Trigger Statuz Alwayz Enabled
Reading Phaze OFF Ext. Trig. Trailing Edge
Image Acquisition Buffer Size 2
ﬂEDLIISITIEIN TRIGGER DELAY 1
Status Dizabled
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Environmental Parameters regard the device Identity and Position in a Network (ID-NET™,
Master/Slave RS232, MUX 32, Ethernet) and are not influenced by the "Send Default
Configuration" and "Send Configuration" commands. This allows individual devices to be
configured differently without affecting their recognized position in the network.

The following is a list of the Environmental Parameters:

READING SYSTEM LAYOUT
- Device Network Setting
- Number of Slaves

DEVICE NETWORK SETTINGS

- Topology Role

- ID-NET Slave Address

- Network Baud Rate

- Acquisition Trigger String  (available only in Multidata configuration)
- Reading Phase ON String (available only in Multidata configuration)
- Reading Phase OFF String (available only in Multidata configuration)

- Header String (available only in Slave Multidata configuration)
- Terminator String (available only in Slave Multidata configuration)
- Link Failure String (available only in Master Synchronized configuration)

- Link Failure Timeout (ms)  (available only in Master Synchronized configuration)

EXPECTED SLAVE DEVICES
- Status

- Device Description

- Device Network Name

MAIN PORT
- Communication Protocol
- Multidrop Address

ETHERNET SYSTEM (on-board)
- Status

- DHCP Client

- IP Address

- Subnet Mask

- Gateway Address

- DNS1 Address
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HOST INTERFACE
- Host Interface Type

CBX ETHERNET SYSTEM (CBX with Host Interface Modules)

- Status

- DHCP Client

- IP Address

- Subnet Mask

- Gateway Address

PROFIBUS
- Node Address

DEVICENET
- Node Address

ETHERNET-IP

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

PROFINET IO

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

CANOPEN
- Node Address

CC-LINK
- Node Address

MODBUS TCP

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

MISCELLANEOUS
- Reader Name

- User Name

- Line Name
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For device replacement it is necessary to send the previously saved configuration (both
Configuration and Environmental parameters) to the new device. To do this select "Send
Configuration with Options" from the Device Menu and check the Environmental Parameters

checkbox:

@Send Options

Dowouwantto send current configuration to dewvice ?

—Farameter Selection
[

v Environment Parameters:

ez X Ma

In order to return a device to its absolute default parameters including Environmental
parameters, the following Send Default Configuration with Options" dialog must be used:

H} Send Defaults Options

Dowouwantto restore default configuration to dewvice 7

—FParameter Selection
=

W Environment Parameters:

q“’ fes x Mo
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8.4.3 Calibration

VisiSet™ provides a Calibration Tool to maximize the reading performance by tuning the
acquisition parameters and the time of the delayed triggers.

By selecting the Calibration Tool from the VisiSet™ Main Menu (F), the following window
appears together with the Parameter Setup window:

E_ﬁ Calibration Tool
Top,Left

~Stop Image Acquizition
+ Dizabled
" Afer dny Capture
(" On Mo Decode
" On Decode

~Screen Mode

Battom Right Tl e ‘

“Image Acquizsition [nfarmation
Acquizition Setting: 1 Self Tuning: Dizabled
Exposure Time (=1 0us]; 35
Gain; 14
-Decoding Results
Symbology: Data Matnix ECC 200 Selected Code: 1 j
Code D ata: [ratalogic 20 Code Reader
Code Center: [H.5]=[375,242)]
Code Orientation: batad Huality Indesx: 1005
[~ Image Lighting Euality
Expozure Index: | | Lighting Indesx: 1005
Underexpozed oK. Overexposed
—Statistical information on the last 10 samples TH/R

Figure 114 - Calibration OK

This tool provides a "real-time" image display while Matrix 210™ is reading. It also gives
immediate results on the performance of the installed Matrix 210™ reader.

If Self Tuning is enabled, the Calibration Tool window indicates the region where the
calibration algorithm is performed: it is within the central box delimited by four red dots.

The Parameter Setup window works in Interactive Mode in order to cause each parameter
setting to be immediately effective.
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NOTE

If you want to save the temporary configuration to permanent memory, you
must first close the Calibration Tool window. Then, you must disable the
Interactive Mode and select the Permanent Memory option from the Send
Configuration item in the Device menu.

The following examples show some of the typical conditions occurring during the installation:

Under-exposure:

To correct this result it is recommended to change the following parameters in their order of

appearance:

1. increase the Exposure Time
2. increase the Gain

NOTE

decoding process.

In general, a longer exposure time corresponds to a lighter image but is
susceptible to blurring due to code movement. Exposure time is also limited
by the Internal Lighting mode parameter. Longer exposure times can be
set if the power strobe level is lowered.

High gain settings may produce a grainy image that may affect the

Eﬂ Calibration Tool

Top,Left

{+ Disabled

" After &ny Capture
" OnNo Decode
" OnDecade

“Screen Mode

(* Decoded Image
" Code Pozition Only
(" Camera Mode

Stop Image Acquisition —

. tH Parameter Setup

File:: [ = Mode

Interactive ‘

Image Proceszing ] Mizcellaneous ] Data Collection
Symbol Verification | Communication ] Diaghostice
Calibration ] LEDs And Keypad ] 20 Codes 1 10 Codes

Postal Codes ]
Match Code ]
Operating Modes

|
|
|

Bottomn, Right
Image Acquisition Infarmation -
Acquisition Setting: 1 Self Tuning: Dizabled
Exposure Time (1 0us): 100
Gair: 10
~Decoding Results
Symbology: Data b atrix ECC 200 Selected Code: rj
Code Data: Datalogic 20 Code Reader
Code Center: [P 1=[396,238)
Code Orientation: a9 Cluality Index:

“Image Lighting Quality

Espasure Index:

Lighting Index:

Underexposed oK Overexposed

“Statistical information on the last 10 samples TA/RX

IMAGE ACQUISITION SETTING 1
Status Enabled
Self Tuning Dizabled
Internal Lighting Mode High-Power Strobed
Exposure Time [«100us] 10
Gain 10
Gain Increazing w1
Image Polarity Inversion Dizabled
Fegion Of Interest: Top 1]
Fiegion OF Interest: Battom 479
Region OF Interest: Left 1]
Fegion OF Interest; Right 751
Image Filker Dizabled

Figure 115 - Example Under Exposure: Too Dark
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Over-exposure:

To correct this result it is recommended to change the following parameters in their order of
appearance:

1. decrease the Gain
2. decrease the Exposure Time

m Calibration Tool @ Parameter Setup
Top Left Stop Image Acquisition File [evice Mode
+ Disabled | [
" After Any Capture J send ‘ Send Defaults ‘ Permanent ‘ Interactive ‘
(" OnNoDecode = =
" UnDecode Postal Codes ] Image Processing | Mizcellansous ] Drata Callection |
5 i Soieen Mode Match Code | S ymbol Yerification | Communication ] Diagnostics ]
@ Decoded Image Operating Modes Calibration ] LED: And keypad ] 2D Codes 1 10 Codes ]
(" Code Position Only IMAGE ACQUISITION SETTING 1
" Camera Mode Status Enabled
| Self Turing Disabled

e Internal Lighting Mode High-Power Strobed
- = = Expozure Time [x100us) 40
Bottarm Right — i

Gain 12

Image Acquisition Informatiors

Acquisition Setting: 1 Self Tuning: Dizabled Gain Increasing #1
Exposure Time [x10us] 400 Image Polarity Inversion Dizabled
Giain 12 Region Of Interest: Top 1]
Decoding Results o Region Of Interest; Battom 479
Sprmbalagy: Data Matriz ECC 200 Selected Code: 1 = 2

% & | Region OF Interest: Left 1]
Code Data: Datalogic 20 Code Reader
Code Center: (% =396 237) Fegion OF Interest; Right 751
Caode Orientation: 89 Guality Index: Image Filker Dizabled

{mage Lighting Quality

Exposure Index: Lighting Index: E
Underexposed oK Overexposed

~Statistical information on the last 10 samples TR

Figure 116 - Example Over Exposure: Too Light
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Moving code out of the Field of View:

To correct this result and have the code completely visible in F.O.V., it is possible to follow
one or both the procedures listed below:

e reposition the reader
e use the Acquisition Trigger Delay by tuning the Delay Time (x100ps)

B calibration Tool tH parameter Setup

ol Stop Image Acquisition File ey Mode
(¢ Disabled
(™ After &y Capture iGet I Send ] Cend Defaull ‘ Permanenl ] Interactive ‘
" OnMNoDecode =
(" OnDecade Postal Codes ] Image Processing ] Mizcellaneous ] Data Collection ]
~Screen Mode- 1 Match Code ] S ymbol Yerification | Communication ] Diagrostics |
(¢ Decoded Image Operating Modes Calibration ] LECrs And Keypad 1 20 Codes 1 1D Codes 1
" Cade Position Only IMAGE ACQUISITION SETTING 1
r -
Heiena Ml Status Enabled
e ] Self Tuning Disabled
i Intemal Lighting Mode High-Power Strobed
= = ; Expozure Tine [x100usz] 1B
Battom Right — Gain 12
Image Acquisition Information - -
Acquisition Setting: 1 Self Tuning: Dizabled Giin Increasing il
Exposure Time [x10us) 160 Image Palarity Irversion Dizabled
Gair: 12 Fiegion OF Interest: Top o
Decading Results o Fiegion OF Interest; Bottom 474
Spmbology: Data Matrix ECC 200 Selected Cods 1 = :
Sy R EEET G = Region OFf Interest: Left 0
Code Data: Datalogic 20 Code Reader - -
Cods Center: (3. = (559, 229) Fegion OF Interest: Right 751
Code Orientation: 92 Quality Index: Image Filter Dizabled

“Image Lighting Quality

Exposure Indes: Lighting Index:

Underexposed oK Overexposed

Statistical information on the last 10 samples TRIRX

Figure 117 - Example out of FOV
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8.4.4 Multi Image Acquisition Settings

When controlled variable conditions occur in the application, Multiple Image Acquisition
Settings (up to 10), can be defined to create a database of parameter groups that handle
each specific application condition. This database of pre-defined settings functions cyclically
and therefore automatically improves system flexibility and readiness.

For example, an application may have two stable but different lighting conditions which
require different lighting options. One Image Acquisition Setting could enable and use the
internal illuminator and a second setting could disable Internal Lighting to use external
lighting. These two groups will be used cyclically on each acquisition in order to automatically
capture the correctly lighted image.

Image Acquisition Settings are found in the VisiSet™ Calibration parameter setup menu.
By selecting a different number and enabling its Status you can define the parameters for a
new group.

8.4.5 Run Time Self Tuning (RTST)

Run Time Self-Tuning (RTST) increases Matrix’s flexibility in the presence of uncontrolled
variable conditions (lighting, code contrast, etc.) by automatically adjusting its acquisition
parameters.

Self Tuning Calibration

In the Calibration parameter setup menu, the Self Tuning parameters manage the Image
Acquisition Setting parameters dynamically. Self Tuning provides automatic adjustment in
run time of different acquisition parameters (Exposure Time and/or Gain) for each captured
image based on calculations performed on previous acquisitions. These dynamic settings will
be used instead of the static settings saved in memory.

From to
Not Readable Readable

For more details see the Matrix 210™ Help On-Line.

Self Tuning Image Processing

In the Image Processing parameter setup menu, the Self Tuning parameters manage the
Image Processing and Symbology related parameters. They perform different processing
attempts on the same captured image according to the selected Self Tuning Mode parameter
value: (Symbologies Only, Processing Modes Only, Decoding Methods Only, Code Contrast
Levels Only, Image Mirroring Only, or General Purpose).

For more details see the Matrix 210™ Help On-Line.
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8.4.6 Region Of Interest Windowing

In order to satisfy very high throughput applications, higher frame rates can be achieved
using the powerful Region Of Interest Windowing parameters in the Calibration parameter
setup menu.

Region Of Interest Windowing allows defining a region or window within the reader FOV.
The Top, Bottom, Left and Right parameters allow to precisely define the image window to
be processed, visualized and saved.

In Matrix 210™ the frame rate is dependent on the number of rows and columns in the
defined window.

The smaller the window, the lower the frame period and consequently the higher the frame
rate. In general the Image Processing time can be reduced by reducing the window
dimensions.

E} Calibration Tool
Top.Left

. EE Parameter Setup

Stop Image Acquisition File Ccvice  Maode
(¢ Disabled
(™ After Any Capture sel | Senc ‘ Send Default ‘ srmanent | Interactive |
(" OnMoDecode
" Or Decods Postal Codes | Image Processing | Miscellaneous ] Data Callection |
~Sereen Mode- Match Code ] Symbol Yerification ] Commmunication ] Diagnostics |
(¢ Decoded Image Operating Modes Calibration l LEDs &nd Keypad ] 2D Codes ] 10 Codes ]
¢ Code Posiion Only IMAGE ACQUISITION SETTING 1
~
SR Status Enabled
esbed_| Self Tuning Disabled
e Internal Lighting Made High-Power Strobed
e Expozure Time [«100us] 14
Bottom Right - = i o0
Image Acquisition Information - -
Acquisition Setting: 1 Self Tuning: Dizabled Gain Increasing bl
Exposure Time [x10us) 140 Image Palarity Inversion Disabled
Gairt 20 Region Of Interest: Top 100
Decoding Results o Region Of Interest: Bottom 400
Symbology: Code 33 Selected Code h = g
=4 i
e e Region OF Interest: Left 150
EattiEamar (%) =(378,242) Region Of Interest: Right 600
Code Orientation: 180

“Image Lighting Duality

Exposure Indes: Lighting Index:
Underexposed 0K Overexposed
“Statistical infarmation an the last 10 samples THIRX
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8.4.7 Direct Part Marking Applications

Decoding Method: Direct Marking

For Data Matrix and QR code the Decoding Method parameter selects the decoding
algorithm according to the printing/marking technique used to create the symbol and on the
overall printing/marking quality. The Direct Marking selection improves the decode rate for
low quality Direct Part Mark codes and in general for Direct Part Mark codes with dot peening

type module shapes.

Washed out and Axial Dot Peening On

A ; Low Contrast
Distortion Scratched Surface Problem

Axial
distortion

Background Marked On Curved
Problems Shiny Surface

Low contrast,
noisy background

Half

Shiny surface,
noisy background

All the previous examples are successfully read selecting the Direct Marking Decoding
Method.
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Image Filter
Sets the filter to be applied to the image before being processed. This parameter can be
used to successfully decode particular ink-spread printed codes (i.e. direct part mark codes).

A different filter can be applied to each Image Acquisition Setting.

The Erode Filter enlarges the image dark zones to increase readability.

Before - No Read After - Readable

Erode

The Dilate Filter enlarges the image white zones to increase readability.

® s ssnns
- -
.- Ssees =
- & =

"800
.

Before - No Read After - Readable

Dilate

The Close filter eliminates dark areas (defects) in the white zones of the image.

Before - No Read After - Readable
Close
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The Open filter eliminates white areas (defects) in the dark zones of the image.

il T
e e

Before - No Read After - Readable
Open

The Contrast Stretching filter maximizes image contrast.

o ;‘I!’ i;lf Eﬂ:
ﬁic ey
s _-i'vm

Before - No Read After - Readable
Contrast Stretching
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The Histogram Equalization filter makes the gray level distribution uniform.

Before - No Read After - Readable

Histogram Equalization

The Smoothing filter deletes small (insignificant) details in the center of the image.

Before - No Read After - Readable
Smoothing

The Sharpening filter improves out of focus images.

Before - No Read After - Readable
Sharpening
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The Deblurring filter improves blurred images.

Before - No Read After - Readable
Deblurring

The Black Enhancement filter produces a nonlinear increase in the black level for light
images.

Before - No Read After - Readable

Black Enhancement

The White Enhancement filter produces a nonlinear increase in the white level for dark
images.

Before - No Read After - Readable

White Enhancement
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8.5 IMAGE CAPTURE AND DECODING

By using the Capture Image and Decode Last Image functions from the VisiSet™ Main
menu, you can get information about the image decodable codes in terms of Symbology,
encoded Data, Position and Orientation, Decode Time and Code Quality Assessment Metrics.

File Edit Conmect Disconnect Dewice Options Tools Help

MAIN MEHU Image captured (752x480) using Acquisition Setting #1 (Self Tuning

disabled) .

M. Setup Wizard Ahkhkhhhkhkhdhkhdk Tmage Processing started (#1):

F. Calibration Tool
\I. Symbol Verification

A. Run Mode

Hew Code {(#4.1):
Symbology: Data Ma
Humber of Charac
Code Center Posi

B. Capture Image
Code Orientation: 276°
Code Bounds: TL[618,251] TR[632,402] BL[465,257] BR[475,407]
Symbol Size: 20x20
Code Quality Index: 100%
IS0-IEC 16022-18004 Quality Indicators:
Orerall Grade
Symbol Contrast
Print Growth
Axial Hon Uniformity
Unused Error Correction: A {10
Data: Datalogic 2D Code Reader

C. Decode Last Image
D. View Last Image

E. Download Last Image
H. Upload Bitmap Image
G. Store Match Code

0. Image Buffer

Image Exposure (Quality: 100%
Image Processing Time (ms): 12

3. Button Function Menu

*kARARARAAARANAH Tmage Processing completed (#1) .

.Cﬂnnectmn: 08012005 on COMI at 115200,M,8,1 Reader Status! OFF LINE MODE \Log : OFF

Figure 118 - Capture and Decoding Functions

8.6 STATISTICS

Statistics on the reading performance can be viewed by enabling the Statistics parameter
and selecting the View Statistics item in the File menu. One of three different windows
appears depending on the operating mode.

Refer to the VisiSet™ Help On Line for more details.

Total Samples

Acquiztion Caunter: 1000
Complete Read Counter: 1000
Complete Reads [%]: 100.00
Last Samples

Acquiztion Counter: 20
Complete Read Counter: 20
Complete Reads (%) 100.00
Reading Performance

tean Decoding Time [ms): 22
Max Decoding Time [ms): 22
Frame R ate (Images/s): 14

Last Decoded Code
Drata Matix ECC 200
Datalogic 20 Code Reader

Symbalogy:
Code D ata;

Close

Reset ‘

Figure 119 - Code Statistics
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9 MAINTENANCE

9.1 CLEANING

Clean the reading window (see Figure A, 1) periodically for continued correct operation of the
reader.

Dust, dirt, etc. on the window may alter the reading performance.
Repeat the operation frequently in particularly dirty environments.

Use soft material and alcohol to clean the window and avoid any abrasive substances.
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10 TROUBLESHOOTING

10.1 GENERAL GUIDELINES

When wiring the device, pay careful attention to the signal name (acronym) on the
CBX100/500 spring clamp connectors (chp. 4). If you are connecting directly to the
Matrix 210™ 25-pin male D-sub connector pay attention to the pin number of the signals
(chp. 5).

If you need information about a certain reader parameter you can refer to the VisiSet™
program help files. Either connect the device and select the parameter you're interested in
by pressing the F1 key, or select Help>Paramters Help from the command menu.

If you’re unable to fix the problem and you’re going to contact your local Datalogic office or
Datalogic Partner or ARC, we suggest providing (if possible): Application Program version,
Parameter Configuration file, Serial Number and Order Number of your reader. You can
get this information while VisiSet™ is connected to the reader: the Application Program
version is shown in the Terminal Window; the Parameter Configuration can be saved to an
.ini file applying the File>Save Configuration File command in the Parameter Setup
window; Serial Number and Order Number can be obtained by applying the respective
command in the Tools menu.

TROUBLESHOOTING GUIDE

Problem

Suggestion

Power ON:
the “POWER” LED is not lit.

¢ |s power connected?

e If using a power adapter (like PG6000), is it connected
to wall outlet?

e If using rail power, does rail have power?

e If using CBX, does it have power (check switch and
LED)?

e Check if you are referring to the 25-pin connector or to
the CBX spring clamp connectors.

e Measure Voltage either at pin 13 and pin 25 (for 25-pin
connector) or at spring clamp Vdc and GND (for CBX).

One Shot or Phase Mode
using the Input 1 (External
Trigger) or Input 2:

the "TRIGGER” LED is not
blinking while the External
Trigger is switching.

e Check if you are referring to the 25-pin connector or to
the CBX spring clamp connectors.

e Is the sensor connected to the Input 1 or Input 2?

¢ |s power supplied to the photo sensor?

e For NPN configuration, is power supplied to one of the
two I1 or 12 signals (A or B)?

o For PNP configuration, is one of the two I1 or |12 signals
grounded (A or B)?

+ Are the photo sensor LEDS (if any) working correctly?

¢ |s the sensor/reflector system aligned (if present)?

¢ In the Digital I/O folder check the EXTERNAL
TRIGGER or INPUT 2\Debounce Filter parameter
setting.

¢ In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.
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TROUBLESHOOTING GUIDE

Problem

Suggestion

One Shot or Phase Mode
using serial trigger source:
the "TRIGGER” LED is not
blinking.

In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.

Are the COM port parameters (Baud Rate, Parity, Data
Bits, Stop Bits, Handshake) correctly assigned?

In the communication folder, check the settings of
Reading Phase-ON String, Acquisition Trigger
String and Reading Phase-OFF String parameters.

Is the serial trigger source correctly connected?

Phase Mode:

the "TRIGGER" LED is
correctly blinking but no image
is displayed in VisiSet™
Calibration Tool window.

Is the Phase frequency lower than the maximum frame
rate?

Continuous Mode:
the "TRIGGER” LED is not
blinking.

Verify the correct software configuration settings.

Any Operating Mode:

the "TRIGGER” LED is
correctly blinking but no result
is transmitted by the reader at
the end of the reading phase
collection.

In the Data Collection folder check the settings for the
CODE COLLECTION, DATA FORMAT and
STATISTICS parameter groups.

Image not clear:

Verify the Focus procedure

Image focused but not
decoded:

Verify the Calibrate Image Density prodcedure.

Reading:
the reader always transmits
the No Read Message

Run the Rapid Configuration procedure in chapter 1.
Position the reader as described in par. 3.3 and through
the VisiSet™ Calibration Tool:

Tune the ACQUISITION TRIGGER DELAY, if the
moving code is out of the reader field of view;

Set the Continuous Operating Mode if no external
trigger source is available;

Tune the IMAGE ACQUISITION SETTING to
improve the code image quality;

Check the parameter setting in Decoding,

2D Codes, 1D Codes, and Postal Codes folders;
View the full resolution code image to check the
printing or marking quality.

Communication:
reader is not transmitting
anything to the host.

Is the serial cable wiring correct?

If using CBX, be sure the RS485 termination switch is
OFF.

Are the host serial port settings the same as the reader
serial port settings?

In VisiSet™ Digital 1/0 folder, "COM" LED can be
configured to indicate MAIN COM port TX or MAIN
COM port RX.
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TROUBLESHOOTING GUIDE

Problem

Suggestion

Communication:

data transferred to the host
are incorrect, corrupted or
incomplete.

Are the host serial port settings the same as the reader

serial port settings?

In VisiSet™ Communication folder check the settings of

Header and Terminator String parameters.

In VisiSet™ Data Collection folder, check the settings of
DATA FORMAT parameter group.

How do | obtain my reader
Serial Number?

The reader Serial Number consists of 9 characters: one
letter, 2 numbers, another letter followed by 5 numbers.
The reader Serial Number is printed on a label that is
affixed on the bottom case near the reading window.
The Serial Number can also be obtained by selecting
Tools/Get Reader Serial Number from the command
menu in VisiSet™. A dedicated window will appear.

How do | obtain my reader
Order Number?

The reader Order Number consists of 9 numbers.

The reader Order Number can be obtained by selecting
the Tools/Get Reader Order Number from the command
menu in VisiSet™. A dedicated window will appear.
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MATRIX 210™ REFERENCE MANUAL

11 TECHNICAL FEATURES

ELECTRICAL FEATURES

Matrix 210 21x-x0x

Matrix 210 21x-x1x

Matrix 210 21x-x2x

Power
Supply Voltage
Consumption

10 to 30 Vdc
0.35t00.13A,3.9W
max.

0.16A @24 V.

10 to 30 Vdc
0.41t00.15A, 4.5 W max

0.18A @24V

5 Vdc
0.5A, 2.5 W max

Communication Interfaces
Main

- RS232

- RS485 full-duplex

- RS485 half-duplex
Auxiliary - RS232

2400 to 115200 bit/s
2400 to 115200 bit/s
2400 to 115200 bit/s
2400 to 115200 bit/s

2400 to 115200 bit/s
2400 to 115200 bit/s
2400 to 115200 bit/s
2400 to 115200 bit/s

USB 2.0 up to 921600
bit/s

Input 1 (External Trigger) and Input 2

insensitive

ID-NET™ Up to 1MBaud Up to 1MBaud
Ethernet 10/100 Mbit/s
Inputs Opto-coupled and polarity | Opto-coupled and polarity

insensitive

Max. Voltage

30 Vdc

30 Vdc

Max. Input Current

10 mA

10 mA

Outputs
Output 1 and Output 2

Opto-coupled

Opto-coupled

Vout (ILoag = 0 mA) Max. 30 Vdc 30 Vdc
Vout (ILoag = 10 mA) Max. 1.8 Vdc 1.8 Vdc
Po = Vout X lLoad Max. 170 mW 170 mW

OPTICAL FEATURES

Image Sensor

CMOS sensor with Global Shutter

Image Format

WVGA (752x480)

Frame Rate up to 60 frames/sec. @ full window size
Pitch +35°

Tilt 0° - 360°

Lighting System Internal llluminator

LED Safety to EN 62471

ENVIRONMENTAL FEATURES

Operating Temperature *

0 to 50 °C (32 to 122 °F)

Storage Temperature

-20 to 70 °C (-4 to 158 °F)

EN 60068-2-27

3 shocks on each axis

Max. Humidity 90% non condensing

Vibration Resistance 14 mm @ 2 to 10 Hz; 1.5 mm @ 13 to 55 Hz;
EN 60068-2-6 2 g @ 70 to 200 Hz; 2 hours on each axis
Bump Resistance 30g; 6 ms;

EN 60068-2-29 5000 shocks on each axis

Shock Resistance 30g; 11 ms;

Protection Class

IP65

EN 60529

PHYSICAL FEATURES Matrix 210 21x-1xx models Matrix 210 21x-0xx models
Dimensions 50 x 25 x 45 mm (1.97 x 0.98 x 1.77 in) | 54 x 32 x 45 mm (2.13 x 1.26 x 1.77 in)
Weight 204 g. (7.2 oz.) with cable 190 g. (6.7 oz.) with cable

Material ZAMA Aluminium alloy

* high ambient temperature applications should use metal mounting bracket for heat dissipation
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TECHNICAL FEATURES

SOFTWARE FEATURES

Readable Code Symbologies

1-D and stacked

2-D POSTAL

Code 128 (GS1-128)

Code 39 (Standard and Full ASCII)
Code 32

o MSI

e Standard 2 of 5

o Matrix 2 of 5

Interleaved 2 of 5

Codabar

Code 93

Pharmacode

e EAN-8/13 - UPC-A/E
(including Addon 2 and Addon 5)

e GS1 DataBar Family
e Composite Symbologies

e o

e o o

PDF417 Standard and Micro PDF417

o Data Matrix ECC 200 Australia Post
(Standard, GS1 and Direct Marking)

e Royal Mail 4 State Customer
e QR Code e Kix Code
(Standard and Direct Marking) o Japan Post
¢ Micro QR Code e PLANET
* MAXICODE o POSTNET

* Aztec Code  POSTNET (+BB)

¢ Intelligent Mail
e Swedish Post

Operating Mode

ONE SHOT, CONTINUOUS, PHASE MODE

Configuration Methods

X-PRESS™ Human Machine Interface
Windows-based SW (VisiSet™) via serial, Ethernet or USB link
Serial Host Mode Programming sequences

Parameter Storage

Permanent memory (Flash)

CODE QUALITY VERIFICATION

Standard

Supported Symbologies

ISO/IEC 16022
ISO/IEC 18004
ISO/IEC 15415
ISO/IEC 15416
AS9132A
AIM DPM

Data Matrix ECC 200

QR Code

Data Matrix ECC 200, QR Code

Code 128, Code 39, Interleaved 2 of 5, Codabar, Code 93, EAN-8/13, UPC-A/E
Data Matrix ECC 200

Data Matrix ECC 200, QR Code

USER INTERFACE

LED Indicators

Power, Ready, Good, Trigger, Com, Status, (Ethernet Network), (Green Spot)

Other

Keypad Button (configurable via VisiSet™); Beeper
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GLOSSARY

AIM
(Association for Automatic Identification and Mobility): AIM Global is the international trade
association representing automatic identification and mobility technology solution providers.

AIM DPM Quality Guideline

Standard applicable to the symbol quality assessment of direct part marking (DPM)
performed in using two-dimensional bar code symbols. It defines modifications to the
measurement and grading of several symbol quality parameters.

AS9132
Standard defining uniform quality and technical requirements for direct part marking (DPM)
using Data Matrix symbologies.

Barcodes (1D Codes)

A pattern of variable-width bars and spaces which represents numeric or alphanumeric data
in machine-readable form. The general format of a barcode symbol consists of a leading
margin, start character, data or message character, check character (if any), stop character,
and trailing margin. Within this framework, each recognizable symbology uses its own unique
format.

BIOS
Basic Input Output System. A collection of ROM-based code with a standard API used to
interface with standard PC hardware.

Bit

Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits
compose one byte of data. The pattern of 0 and 1 values within the byte determines its
meaning.

Bits per Second (bps)
Number of bits transmitted or received per second.

Byte

On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to
represent a specific character or numeric value. Bits are numbered from the right, 0 through
7, with bit O the low-order bit. One byte in memory can be used to store one ASCII character.

Composite Symbologies
Consist of a linear component, which encodes the item's primary data, and an adjacent 2D
composite component, which encodes supplementary data to the linear component.

Dark Field lllumination
Lighting of surfaces at low angles used to avoid direct reflection of the light in the reader’s
lens.

Decode
To recognize a barcode symbology (e.g., Codabar, Code 128, Code 3 of 9, UPC/EAN, etc.)
and analyze the content of the barcode scanned.
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Depth of Field
The difference between the minimum and the maximum distance of the object in the field of
view that appears to be in focus.

Diffused lllumination
Distributed soft lighting from a wide variety of angles used to eliminate shadows and direct
reflection effects from highly reflective surfaces.

Direct Part Mark (DPM)
A symbol marked on an object using specific techniques like dot peening, laser etching,
chemical etching, etc.

EEPROM
Electrically Erasable Programmable Read-Only Memory. An on-board non-volatile memory
chip.

Element
The basic unit of data encoding in a 1D or 2D symbol. A single bar, space, cell, dot.

Exposure Time
For digital cameras based on image sensors equipped with an electronic shutter, it defines
the time during which the image will be exposed to the sensor to be acquired.

Flash
Non-volatile memory for storing application and configuration files.

Host

A computer that serves other terminals in a network, providing services such as network
control, database access, special programs, supervisory programs, or programming
languages.

Image Processing
Any form of information processing for which the input is an image and the output is for
instance a set of features of the image.

Image Resolution
The number of rows and columns of pixels in an image. The total number of pixels of an
image sensor.

Image Sensor
Device converting a visual image to an electric signal. It is usually an array of CCD (Charge
Coupled Devices) or CMOS (Complementary Metal Oxide Semiconductor) pixel sensors.

IEC
(International Electrotechnical Commission): Global organization that publishes international
standards for electrical, electronic, and other technologies.

IP Address

The terminal’s network address. Networks use IP addresses to determine where to send
data that is being transmitted over a network. An IP address is a 32-bit number referred to as
a series of 8-bit numbers in decimal dot notation (e.g., 130.24.34.03). The highest 8-bit
number you can use is 254.
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ISO
(International Organization for Standardization): A network of the national standards
institutes of several countries producing world-wide industrial and commercial standards.

LED (Light Emitting Diode)
A low power electronic light source commonly used as an indicator light. It uses less power
than an incandescent light bulb but more than a Liquid Crystal Display (LCD).

LED llluminator
LED technology used as an extended lighting source in which extra optics added to the chip
allow it to emit a complex radiated light pattern.

Matrix Symbologies (2D Codes)

An arrangement of regular polygon shaped cells where the center-to-center distance of
adjacent elements is uniform. Matrix symbols may include recognition patterns which do not
follow the same rules as the other elements within the symbol.

Multidrop
A communication protocol for connecting two or more readers in a network with a
concentrator (or controller) and characterized by the use of individual device addresses.

Multi-row (or Stacked) Symbologies
Symbologies where a long symbol is broken into sections and stacked one upon another
similar to sentences in a paragraph.

RAM
Random Access Memory. Data in RAM can be accessed in random order, and quickly
written and read.

Symbol Verification
The act of processing a code to determine whether or not it meets specific requirements.

Transmission Control Protocol/Internet Protocol (TCP/IP)

A suite of standard network protocols that were originally used in UNIX environments but are
now used in many others. The TCP governs sequenced data; the IP governs packet
forwarding. TCP/IP is the primary protocol that defines the Internet.
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